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Package Contents

Contents of Package:

D-Link DI-704UP Express EtherNetwork '
Broadband Router with USB Print Server

Manual, Warranty and Print Server Software on CD
Quick Installation Guide
Power Adapter - AC 5V, 2A
B CATS5 Ethernet Cable
If any of the above items are missing, please contact your reseller.

the one included with the DI-704UP will cause damage and void the

Q WARNING! Using a power supply with a different voltage rating than
warranty for this product.

System Requirements for Configuration:

B Computer with Windows, Macintosh, or Linux-based Operating
System with an installed Ethernet adapter

B Internet Explorer version 6.x, Netscape Navigator version 6.x
and above, or another Internet Browser application with
Javascript enabled



Introduction

Thank you for purchasing the DI-704UP Express EtherNetwork Broadband Router
with USB Print Server. The DI-704UP is an Ethernet Broadband Router with a
built-in 4-port switch. It also features a USB port to share a USB printer on the
home or office network and includes a print server application for Windows. As
many as four computers can be connected directly to the router’s integrated
switch, using its four 10/100Mbps AutoMDIX Ethernet ports. More computers
can be added to the network by connecting additional switches to the DI-704UP.
The DI-704UP package even includes an Ethernet cable to get you started.

The DI-704UP is ideal if you are creating your first home or small business
network, or if you are a more advanced user looking for additional management
settings.

The DI-704UP includes a new, easy-to-use D-Link web-based graphical user
interface (GUI) to configure the router. To prevent unwanted Internet intruders
from accessing your private network, the DI-704UP also serves as a feature-
rich firewall.

So, whether you are a college student who wants to network with friends and
roommates, an executive working at home or in a small office, or a concerned
parent who just wants to have more control over how your children access the
Internet, then the D-Link DI-704UP Express EtherNetwork Broadband Router
with USB Print Server is the networking solution for you.



Features & Benefits

B Firewall Features

m Filtering - Easily applied filtering based on Media Access Con-
trol (MAC) Addresses, IP Addresses, Port Addresses, and time
schedule allows or denies computer on the network access to
the Internet.

B Network Address Translation - NAT allows your private net-
work to share a single public IP address. All your computer con-
nected to the DI-704UP will be on a private network shielded
from Internet intruders.

B Built-In 4-Port Switch - Allows you to quickly and easily share an Internet
connection with multiple computers and devices. Each 10/100 Ethernet
Port automatically senses and accepts the type of Category (CAT) 5
cable you attach - whether straight through or cross-over. Connect ad-
ditional switches to allow more computer to access the Internet.

B Built-In Print Server - Includes a USB port to connect to a USB printer
and includes a Windows-based print server software application, so
users on the network can share the printer. The print server is also ca-
pable of TCP/IP printing.

B Ethernet Cable Included - One Ethernet cable is included with the DI-
704UP to get you started.

B Simple Setup Wizard for Easy Installation - The D-Link setup wizard
simplifies the installation process, getting you up and running in just a
few clicks.



LEDs

Status LED WAN LED Printer LED

o foanban| { Statu [ WAN]
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POWER LED LOCAL NETWORK LEDs
LED Activity
Power A solid light indicates a proper connection to
the power supply.
Status Flashes consistently to indicate that the

DI-704UP is working properly. Asolid light
indicates that the unit is not working

properly.

WAN A Solid light indicates connection on the
WAN port. This LED blinks during data
transmission.

LOCAL A solid light indicates a connection to an
NETWORK Ethernet-enabled computer on ports 1-4. This
LEDs LED blinks during data transmission.
(Ports 1-4)
Printer A solid light indicates a proper connection to a
printer.




Con

nections

Printer Port WAN Port Reset Button

LAN Ports Receptor for Power Adapter

Printer Port. Doing so may cause damage and void the warranty for
this product.

Q WARNING! Do not plug anything other than a USB printer into the

; Connect the supplied power adapter that came
Receptgr or with the unit. Using the wrong power adapter will
Power Adapter damage the unit.
Reset Button Reset buttc_)n is to reset the device to its factory
default settings.
: Connect to the printer using a USB cable. This
Printer Port . .
feature is used to share the printer on the network.
WAN Port WAN port is the connection point for your DSL or
Cable modem.
e LAN port is where you would connect each
computer to your network.

AN

WARNING!

Using a power supply with a different voltage rating than the one in-
cluded with the DI-704UP will cause damage and void the warranty for
this product.




Introduction to Broadband
Router Technology

A router is a device that forwards data packets from a source to a destination.
Routers can work on Open System Interconnection (OSI) layer 3, which for-
wards data packets using an IP address and not a MAC address. A router will
forward data from the Internet to a particular computer on your LAN.

The information that makes up the Internet gets moved around using routers.
When you click on a link on a web page, you send a request to a server to show
you the next page. The request sent and the information received by your com-
puter is moved from your computer to the server using routers. A router also
determines the best route that your information should follow to ensure that the
information is delivered properly.

A router controls the amount of data that is sent through your network by elimi-
nating information that should not be there. This provides security for the com-
puters behind your router because computers from the outside cannot access
or send information directly to any computer on your network. The router deter-
mines which computer the information should be forwarded to and sends it. If
the information is not intended for any computer on your network, the data is
discarded. This keeps any unwanted or harmful information from accessing or

damaging your network.

Introduction to Firewalls

A firewall is a device that sits between your computer and the Internet that pre-
vents unauthorized access to or from your network. A firewall can be a com-
puter using firewall software or a special piece of hardware built specifically to
act as a firewall. In most circumstances, a firewall is used to prevent unautho-
rized Internet users from accessing private networks such as corporate LANs
and Intranets.

A firewall watches all of the information moving to and from your network and
analyzes each piece of data. Each piece of data is checked against a set of
criteria that the administrator configures. If any data does not meet the criteria,
that data is blocked and discarded. If the data meets the criteria, the data is
passed through. This method is called packet filtering.

A firewall can also run specific security functions based on the type of applica-
tion or type of port that is being used. For example, a firewall can be configured
to work with an FTP or Telnet server. Or a firewall can be configured to work
with specific UDP or TCP ports to allow certain applications or games to work

properly over the Internet.
8



Introduction to Local Area Networking

A Local Area Network (LAN) is typically an Ethernet-based network that con-
nects several computers together over a small area such as a building or group
of buildings. LAN’s can aso be connected over large areas. A collection of LANS
connected over a large area is called a Wide Area Network (WAN).

There are many types of media that can connect computers together. The most
common media is CAT5 cable; UTP or STP twisted pair wire. Each computer
must have a Network Interface Card (NIC), which transfers the data between
computers. A NIC is usually a 10/100Mbps Fast Ethernet adapter.

Most networks use hardware devices such as hubs or switches to transfer
data between computers. A hub receives data arriving through each port and
forwards the data to all other ports. A switch is more sophisticated, in that a
switch can determine the port (or corresponding computer) that each packet of
data is supposed to be delivered to. A switch minimizes network traffic and
speeds up communication over a network.

There are many types of scenarios to consider which could affect the operabil-
ity of a network. Some of these issues are discussed in the manual under the
Networ king Basics section.



Sample Scenario

Internet

I Cable/DSL Modem ‘ @
S Computer 2
5 DI-704U P Desktop PC or Laptop
2l Ethemet
Broadband Router 3
E == USB

=" Printer

B¢ b 2T
Computer 1 @
Desktop PC or Laptop

A typical network setup in a home or small office (as shown above) might contain the
following devices. For specific information on setting up your network with the DI-704UP
please see the Network Setup section on the following page.

0 You will need broadband Internet access (a Cable or DSL subscription line into
your home or office).

Consult with your Cable or DSL provider for proper installation of the modem.

Connect the Cable or DSL modem to the DI-704UP wireless broadband router.
(See the Quick Installation Guide included with the DI-704UPR)
If you are connecting a desktop computer that does not already have an avail-
able Ethernet port to your network, you can install the D-Link DFE-530TX+

Ethernet adapter into an available PCI slot. (See the Quick Installation Guide
included with the DWL-530TX+.)

If you are connecting a laptop computer without an available Ethernet port to
your network, install an Ethernet Cardbus adapter (e.g., D-Link DFE-690TXD)
and its drivers into the laptop computer. (See the Quick Installation Guide
included with the DFE-690TXD.)

Connect your USB printer to the USB printer port on the DI-704UP. Please
refer to the Quick Installation Guide for loading the Windows print server
software if on a Windows-based computer.

** Easily upgrade to a wireless network by adding a wireless Access Point (D-Link DWL-900AP+) ** 10

®© ® O



Network Setup

(2

3

Internet

Computer 2
Desktop PC or Laptop

=" Printer

Computer 1
Turn everything off.
A. Power OFF your Cable or DSL modem. If your modem does
not have an on/off switch, disconnect the power cable.
B. Turn OFF your computer.
C. Do NOT connect the power adapter to your D-Link router.

Connect the D-Link Router Cables.

A. Connect the Ethernet (or networking) cable from the Cable or
DSL modem to the WAN port of the router.

B. Use the D-Link supplied Ethernet cable to connect the Ethernet
port (Network Card) of your computer to one of the LAN ports of
the router. The complete setup should look like the image shown
above.

Power up the devices in sequence.

A. Power up the Cable or DSL modem. Wait until the modem has
made the connection to your Internet Service Provider’s (ISP’s)
network.

Note: Please see the Manual included with your modem for an explanation of
the modem’s LEDs.

B. Power up the D-Link router by connecting the D-Link provided
power adapter to the router and to an available power outlet.

C. Turn on your computer.

D. Now, refer to either the Quick Installation Guide or continue

to follow this manual to complete the installation process.
11



Using the Setup Wizard

2 D-Link DI-704UP Web Configuration

File Edit Yiew Favorites Tools Help

Open your Web browser and

type “ http://192.168.0.1” into the Qe - @ @ Hh

URL address box. Then press the

Enter or Return key. RHU_BFE_ '_!http:ﬁwz.lﬁﬁ.n.lf

The logon pop-up screen will appear.

Connect to 192.168.0.1
A

CI-7041P

Type “admin” for the username and
leave the password field blank.

User name:

Password:

[Jremember my password

Click OK

0] 4 Cancel ]

D-Link

UG Networks for People

DI-704UP
Ethernet Broadband Router

Once you have logged in, the Home
screen WI“ appear. ‘}Hm?e Advanced = Tools Staius .

.

easy
Wizard setup will allow you to have Internet access within minutes. Please follow the
setup wizard step by step to configure the DI.704UP.

T wan
" " R wizard
Click Run Wizard o

12



Using the Setup Wizard (continued)

23 Setup Wizard - Microsoft Internet Explorer EHE”Z|

D-Lin T o e

et herac T o

You will see the following screens. DIE/08UESetupawWIZard

Welcome to the DI-T04LUP Setup Wizard. The Wizard will guide you thraugh
these four quick steps Begin by clicking on Next.

Step 1. Set your new passward
Step 2. Choose yourtime zone
Step 3. Set Internet connection

Step 4. Restart

Click Next Q0

Next | Exit

A Setup Wizard - Microsoft Internet Explorer EHE”E
D-Link D702 UP S Ctup I Zara;
Set Password
You may change the admin account passwoard by entering in a new password.
Se': Up your neyv password. Click Next to continue.
You have the option to
establish a password. 0ld Passward [sesesssess]
MNew Password | |
Reconfirm | |
s u[o]o
- Back Cancel{ Next J Exit
Click Next

13



Using the Setup Wizard (continued)

2 Setup Wizard - Microsoft Internet Explorer E|@[X|
Set up your Time Zone. You DIF704UP Setup WiZara)
have the option to the set :
standard time for your router. RiaoRe s ol
To change the default Select the appropriate time zone for your location and click Next to continue.
selection, select the drop | (GMT-08:00)Pacific Time (US & Canads) vi

down arrow and choose the
correct time zone.

Click Next @ =9 Q L‘i"

Back Cancel |[Next] Exit

22 Setup Wizard - Microsoft Internet Explorer

UIS/USUEOCLUPRYIZara
Select Internet Connection Type (WAN)

Select your Internet Selectthe connection type to connect to your ISP. Click Next to continue.

Connection. You will be Choose this option to obtain an IP address
) (&) Dynamic IP Address automatically from your ISP. {(For most

prompted to select the Cable modem users)

type of Internet connection Olstlle b aiiaee Choose this option to set static IP

information provided to you by your ISP.

Choose this option if your ISP uses
PPPoE. (For most DSL users)

O Others PPTP and BigPond Cable.

for your router.
) PPF over Ethernat

& If you are unsure of which setting to select,
please contact your Internet Service Provider.

Q V|Q|lv
Back Cancel| Next | Exit
Click Next 1

Select Others only if you use PPTP in Europe or
BigPond Cable in Australia.

14



Using the Setup Wizard (continued)

If you selected DynamiC P 3 Setup Wizard - Microsoft Internet Explorer

Address, this screen will DIE7040P Setup i zara
appear: (Used mainly for Set Dynamic IP Address

Cable Internet SerV'Ce-) Ifyour ISP reguire you to enter & specific host name ar specific MAC

address, please enter itin The Clone MAC Address hutton is used to
copy the MAC address of your Ethernet adapter to the DI-704UP. Click

4P "N\ Mext to continue.
Click the “Clone MAC Address”
button to automatically copy the resttleme | lesmenah
MAC address of the network o Je fos fe B= fo |
adapter in your computer. You can [ [ cineic addess )
also manually type in the MAC

kaddress. )
What is a MAC address? Each
network adapter has a discrete ’ pe
Media Access Control (MAC) u’ Q '3
address. Note that some computers Cancel| Next | Exit
and peripherals may already
include built-in network adapters. J
Click Next
3 Setup Wizard - Microsoft Internet Explorer E|E”X|
If your ISP requires a Static DIE/04UFSettpiWizard,
P Address, and this option Set Static IP Address
is sel ected, then this Enter in the static IP information provided to you by your ISP, Click Next

screen will appear: to cantinue.

AN [P Address [0.0.00 |

Enter the IP Address informa- VAN SubnetMask (2552652550 |
tion originally provided to you WAN Gateway [0.0.00 |
by your ISP. You will need to PimaONS o000 |

complete all the listed fields.

Secondary DME ED.D.D.D |

Click Next

Back Cancel




Using the Setup Wizard (continued)

If your ISP uses PPPoE
(Point-to-Point Protocol over
Ethernet), and this option is
selected, then this screen will
appear: (Used mainly for DSL
Internet service.)

Please be sure to remove any
existing PPPOE client software
installed on your computers.

2l Setup Wizard - Microsoft Internet Explorer

Enter in the username and
password provided to you by
your ISP.

FEX

DIS/08U S ELUPRNIZATO)
Set PPPoE

The service name is optional but may be required by your [SP. Click
Next to continue.

PPPOE Account | |

PPPoE Password E.......... |

Retype Password (seessesses I

FPPoE Service Mame | i(optional)

@a@

Back Cancel Exit

Click Next

43 Setup Wizard - Microsoft Internet Explorer E||E“X|

DI SA0G U ES LUV I ZaTal

Setup Complete

The Setup Wizard has completed. Click on Back to modify changes or
mistakes. Click Restart to =ave the current settings and rehoot the
DI-704LP.

Back |Restart | Exit

Click Restart
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Using the Configuration Menu

Whenever you want to configure your network or the DI-704UP, you can access the
Configuration Menu by opening the web-browser and typing in the IP Address of the DI-
704UP. The DI-704UP default IP Address is shown below:

Open the web browser.
Type in the P Address of

the DI-704UP.

Home > Wizard

‘2 D-Link DI-704UP Web Configuration
File Edit ‘Wiew

Favorites  Tools  Help

@Eack - -M_’I] @ @ :_:‘]

Address | @] hitp://192.168.0.1/

Note: If you have changed the default IP Address assigned to the DI-704UP, make sure to

enter the correct |IP Address.

The factory default User name is
“admin” and the default Password
is blank (empty). It is recommended
that you change the admin password
for security purposes. Please refer to
Tools>Admin to change the admin
password.

Connect to 192.168.0.1

F‘ﬁl A

DI-704LP

User narme: | € admin .vf|

Password: | |

[Jremember my password

I OK H Cancel ]

17



Using the Configuration Menu (continued)
Home > Wizard (continued)
D-Link

Bulsimg Netwarks for Peaple DI'7°4U P
Ethernet Broadband Router

Advanced Tools  Status

Setup Wizard
e 3 The DI704UP is an Ethernet Broadband Router ideal for home networking and

small business networking. The setup wizard will guide you to configure the DI-
T04UP to connect to your ISP {Internet Service Provider). The DIT04UP’s easy
Wizard setup will allow you to have Internet access within minutes. Please follow the
setup wizard step by step to configure the DIT04UP.

il
il o

The Home>Wizard screen will appear upon log in. Please refer to the Quick Instal-
lation Guide for more information regarding the Setup Wizard.

o Clicking Apply will save changes made to the page.
Apply

;’ Clicking Cancel will clear changes made to the page.
Cancel

o Clicking Help will bring up helpful information regarding the page.
Help

@ Clicking Restart will restart the router. (Necessary for some changes.)
Restart

18



Using the Configuration Menu (continued)

Home > WAN (continued)

D-Link

Bulkimg Networks for People

DI-704UP
Ethernet Broadband Router

T W Advanced | Tools Status Help

Flease seleut‘the appropriate option to connectto your ISP

B9

(@ Dynamic IP Address Chonse this option to obtain an P address automatically
frorm your ISP, (For most Cable modern users)
(] Static IP Address Choose this option to set static IP infarmation provided ta
Wizard wou by your ISP
y PPPOE Choosge this option ifyour ISP uses PPPoE. (Formost DSL
users)
L (7 Others PPTF and BigPaond Cahle
]
Host Name |
DHCP MAC Address [oo Lao !.!ns_!.!dﬂ Les Heo |
Primary DMS Address [ooon |
Secondary DNG Address |oooo
MTU [1s00 |
Auto-reconnect @ Enabled O Disabled

@ 9O 0

Apply Cancel Help

WAN is short for Wide Area Network. The WAN settings can be referred to as the
Public settings. All IP information in the WAN settings are public IP addresses which
are accessible on the Internet. The WAN settings consist of four options: Dynamic IP
Address, Static IP Address, PPPoE, and Others. Select the appropriate option and fill

in the information needed to connect to your ISP.

Choose Dynamic IP Address to obtain IP address information automatically from your
ISP. Select this option if your ISP does not give you any IP numbers to use. This option
is commonly used for Cable modem services. Host Name: The Host Name field is
optional but may be required by some ISPs. The host name is the device name of the

Broadband Router.

19



Using the Configuration Menu (continued)
Home > WAN (continued)

MAC Address:

The default MAC address is set to the WAN's physical interface MAC address on the
Broadband Router. You can use the “Clone MAC Address’ button to copy the MAC
address of the Ethernet Card installed by your ISP and replace the WAN MAC
address with this MAC address. It is not recommended that you change the default
MAC address unless required by your ISP

Primary/Secondary DNS Address:
Enter a DNS Address if you do not wish to use the one provided by your ISP,

MTU:
Only enter the MTU if it is required by your ISP. Otherwise, leave it
at the default setting of 1500.

Auto-reconnect:
If enabled, the Broadband Router will automatically connect to your ISP after your
system is restarted or if the connection is dropped.

20



Using the Configuration Menu (continued)
Home > WAN > Static IP Address
D-Link

Butcing Networes or eope DI-704UP

Ethernet Broadband Router
L0 Advanced | Tools Status Help
Please SE‘|EEII1;'IE appropriate option to connect to your ISP,
- () Dynamic IP Address Choose this option to obtain an IP address automatically
B fram your ISP, (For most Cable modem users)
P @ Stafic IP Address Choose this option to set static IP information provided to
Wizard you by your ISP
¢ PPPoE Choose this option ifyour ISP uses PPPoE. (For most DSL
users)
WAN & Others FPTP and BigPond Cable.
e
LAN at Addres
IP Address o000 |
B I
DHCP Subnet Mask |sszsszssn |
ISP Gateway Address E-D- 000 |
Primary DNS Address EEEDHE! |
Secondary DMNS Address |pone i
WTU [1s00 |
2 90
Apply Cancel Help

Choose Static 1P Address if all WAN P information is provided to you by your ISP. You
will need to enter in the IP Address, subnet mask, gateway address, and DNS address(es)
provided to you by your ISP. Each IP address entered in the fields must be in the appropriate
IP form, which are four IP octets separated by a dot (x.x.x.x). The Router will not accept
the IP Address if it is not in this format.

IP Address:
Public 1P address provided by your ISP.

Subnet Mask:
Subnet mask provided by your ISP.

ISP Gateway Address:
Public IP address of your ISP that you are connecting to.

Primary/Secondary DNS Address:
Enter a DNS Address if you do not wish to use the one provided by your ISP

MTU:

Enter an MTU value only if required by your ISP. Otherwise, leave it at the default
setting of 1500.

21



Using the Configuration Menu (continued)
Home > WAN > PPPoE

D-Link

Bulwding Networks for Feople

Wizard

Home

Advanced

DI-704UP
Ethernet Broadband Router

Tools Status Help

Flease select the appropriate option to connect to your [SP.

() Dynamic IP Address
() Static IP Address
@ PPPoE

( Others

UserMName

Password

Retype Password
Service Name

IP Address

Primary DNE Address
Secondary DMS Address
Maximum Idle Time
MTL

Auto-reconnect

Choosge this option to obtain an IP address automatically
from your ISP. (For mast Cable modem users)

Choose thiz aption to set static IP information provided to
yaou hy your ISP,

Choose thiz aption ifyvour ISP uses PPPoE. (Far mostDSL
users)

FPTF and BigFPond Cahle.

® Dynamic PPPoE O Static PPPoE
| |

I | contianan

iMinutes

Enabled O Disabled

9 90

Apply Cancel Help

\

Please be sure to remove any Client Software program on your
computer before you start your configuration of the DI-704UP
Router. Choose PPPoE (Point to Point Protocol over Ethernet)
if your ISP uses PPPOE connection. Your ISP will provide you
with a username and password. This option is typically used for
DSL services. Select Dynamic PPPoE to obtain an |P address automatically
for your PPPoE connection. Select Static PPPoE to use a static |P address
for your PPPOE connection.

22



Using the Configuration Menu (continued)
Home > WAN > PPPoE (continued)

Dynamic PPPOE:
PPPoE connection where you will receive an IP address automatically from your ISP.

Static PPPoE:
PPPoE connection where you have an assigned (static) IP address.

User Name:
Your PPPOE username provided by your ISP.

Password:
Your PPPoE password provided by your ISP

Retype Password:
Re-enter PPPoE password.

Service Name:
Enter the service name provided by your ISP. (optional)

IP Address:

This option is only available for Static PPPoE. Enter in the static IP address for the
PPPoE connection.

Primary DNS Address:
Primary DNS IP provided by your ISP,

Secondary DNS Address:
Optional.

Maximum ldle time:

The amount of time of inactivity before disconnecting your PPPOE session. Enter a
Maximum Idle Time (in minutes) to define a maximum period of time for which the
Internet connection is maintained during inactivity. If the connection is inactive for longer
than the defined Maximum Idle Time, then the connection will be dropped. Either set
this to zero or enable Auto-reconnect to disable this feature.

MTU:

MTU stands for Maximum Transmission Unit. For PPPOE connections, you may need
to change the MTU settings in order to work correctly with your ISP

Auto-reconnect:

If enabled, the Broadband Router will automatically connect to your ISP after your system
is restarted or if the connection is dropped.
23



Using the Configuration Menu (continued)

Home > WAN > PPTP

D-Link

BUlamg Nerworks 1or Peopie

WAN Settings

=

) PPPOE

(& Others
® PPTP

My IP Address

My Subnet Mask
Server IP Address
PPTF Account
FPTF FPassword
Retype Password
Connection 1D
Maxirmum |dle Time

Auto-reconnect

Advanced

(] Dynamic IP Address

() Stafic IP Address

O BigPond Cable

DI-704UP
Ethernet Broadband Router

Tools  Status Help

Please select the approptiate option to connectta your ISP

Choose this option to obtain an IP address autornatically
from your ISP, {(For most Cable modem users)

Chaoase this option to set static IP information pravided to
you by your ISP,

Choose this option if your ISP uses PPPoE. (For most DSL
users)

PPTF and BigPond Cable.

(for Eurape use only)

(for Australia use only)

o000 |
1255.255.255.0

25252550 |
lnona |
e 4

|(Opti0nal)

o iMinutes

@ Enabled O Disabled

VIR

Apply Cancel Help

Dynamic IP Address for PPTP is a WAN connection used in Europe.

My IP Address:

Enter in the |IP address for the PPTP connection.

My Subnet Mask:
Enter the subnet mask information.

Server |P:

Enter the Server IP address. By default, its set to 192.168.0.1

24



Using the Configuration Menu (continued)
Home > WAN > PPTP (continued)

PPTP Account:
Enter in the username for the PPTP account.

PPTP Password:
Enter the password for the PPTP account. Retype in Password to confirm.

Connection ID:
(Optional) Enter the Connection ID if required.

Maximum ldle Time:

The amount of time of inactivity before disconnecting your PPTP session. Enter a
Maximum Idle Time (in minutes) to define a maximum period of time for which the
Internet connection is maintained during inactivity. If the connection is inactive for longer
than the defined Maximum Idle Time, then the connection will be dropped. Either set
this to zero or enable Auto-reconnect to disable this feature.

Auto-reconnect:
If enabled, the device will automatically connect to your ISP after your unit is restarted
or when the connection is dropped.

25



Using the Configuration Menu (continued)
Home > WAN > BigPond Cable

D-Link

Bulkdmng Networks for People

DI-704UP
Ethernet Broadband Router

TP Advanced | Tools @ Status Help

WAN Settings
k Please selectthe appropriate option to connect to vour ISP,
(& Dynamic IP Address Choose this option to obtain an IP address automatically

frarm your ISP. (For most Cable moderm users)

R R () Static [P Address Choose this option to set static IP information provided to
Wizard you by your ISP,
() PPFOE hoose this option if your ISP uses PPPoE. (For most DSL
ugers)

WaH & Others FPTF and BigPond Cable.
o O PRTP (for Europe use onlyy

LAN

& BigPond Cahle (for Australia use only)

I DHCP Dynamic IP Address for BigPone

User Mame |

Faseword [F———

Retype Password [on . |

Login Server IP \ | (optianaly
Auto-reconnect (® Enabled  Disabled

@ 9 0O

Apply Cancel Help

Dynamic IP Address for BigPond is a WAN connection used in Australia.

Account:
Enter in the username for the BigPond account.

Password:
Enter the password for the BigPond account.

Login Server:
(Optional) Enter the Login Server name if required.

Auto-reconnect:
If enabled, the device will automatically connect to your ISP after your unit is re-
started or when the connection is dropped.
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Using the Configuration Menu (continued)
Home > LAN

D-Link

Buling Networks. 1o Peopie DI_7°4U P
Ethernet Broadband Router
Home [LUCUETTET MBS .71 BY Status Help
LAN Settings
Q The IP address of the DI-704UP,
IP Address [1az168.0.1 |
Subnet Mask |255.255 2550 |
l_ st T S |
Ly
J WAN a J 0

Apply Cancel Help
LAN

f DHCP

LAN is short for Local Area Network. This is considered your internal network. These
are the IP settings of the LAN interface for the DI-704UP. These settings may be
referred to as Private settings. You may change the LAN [P address if needed. The
LAN IP address is private to your internal network and cannot be seen on the Internet.

P Address:
The IP address of the LAN interface. The default IP address is 192.168.0.1.

Subnet Mask:
The subnet mask of the LAN interface. The default subnet mask is 255.255.255.0.

Local Domain Name:
This field is optional. Enter in the your local domain name.
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Using the Configuration Menu (continued)
Home > DHCP

D-Link

Buldmg Networks for People DI_704U P
Ethernet Broadband Router
Home [LUUELTAED Tools Status Help
? The DI-704UP can he setup as a DHCP Server ta distribute I addresses to the LAN netwark
DHCP Server @ Enabled O Disabled
Starting IP Address 192_153_0_5100 |
Tl S—
Ending IP Address 192.168.0/199 !
[ Lease Time [1 WEEK v |
WAN
| LAN étatic D'HCIL—' is usedto allow DHCP server to assign same IP to specific MAC address.

O Enabled O Disabled

DHCP _— | |

IF Address 1921680

macaddress| 1 [ [ [ |

DHCP Client |-- select one - v
@ © O
Apply Cancel Help

Mame IF Address MAC Address

Dynamic DHCP Clients List

Host Mame IP Address MAC Address Expired Time

M 192.168.0.118 00-00-39-A3-51-32 ROCTRI I

2003

DHCP stands for Dynamic Host Control Protocol. The DI-704UP has a built-in DHCP
server. The DHCP Server will automatically assign an IP address to the computers on
the LAN/private network. Be sure to set your computers to be DHCP clients by setting
their TCP/IP settings to “Obtain an IP Address Automatically.” When you turn your
computers on, they will automatically load the proper TCP/IP settings provided by the
DI-704UP. The DHCP Server will automatically allocate an unused IP address from the
IP address pool to the requesting computer. You must specify the starting and ending
address of the IP address pool.
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Using the Configuration Menu (continued)
Home > DHCP

Static DHCP allows computers on the LAN to receive the same DHCP IP address
everytime it boots up. You can bind a specific IP address to a specific computer based

on the computer’'s MAC address.

Starting |P address:
The starting IP address for the DHCP server’s IP assignment.

Ending IP address:
The ending 1P address for the DHCP server’s IP assignment.

Lease Time:
The length of time for the IP lease.
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Using the Configuration Menu (continued)

Advanced > Virtual Server

D-Link

Buliing Networks for People DI_7°4U P
Ethernet Broadband Router
SLTITH Advanced RITE Status Help
? Yirtual Server is used to allow Internet users access to LAM services
O Enabled O Disabled
MName | |
Yirtual Server Private IP 182168.0 i‘ |
'_ Protocol Type TCP :,
L L Private Part I*!
P — Pullic Port |
Filter
Schedule O Always
T —= P 1
el | H
Firewall © From Time |00 : i_’T_DLEX!-,mi‘q
day| 5w ¥to|Sun v
l_ ¥
2
Apply Cancel Help
—_—
DDNS
* Mame Private IP. Protacol Schedule
LI Wirlual Server FTP 0.000 TCPZIT abways [0
virtual Server HTTP 0.0.0.0 TCRE0/80  ahways [E]
e =l
bmz virlual Server HTTPS 0.000 TCP 4431443 abways [ il
Yirtual Senver DNS n.00.0 UDP §3/53  always E4i]
Yirtual Server SMTP 0.00.0 TCP 25125  always [
Yirtual Server POP3 0000 TCP 1107110 akways B
virtual Senver Telnet 0.00.0 TCP23(23  always B}
IPSec 0.00.0 TCP 5007800 akways [T
PPTP 1000 TCPITZH ays 2]
1723
DCE1000 0.0.0.0 Both 80780 atwaws [Ea|
DES1000 0.0.0.0 gi’g} S8 hways [ i
DCs2000 0.00.0 Both 80780 always B4
Biath 5001- -
Des2000 0000 500375001 always ELiT]
5003

The DI-704UP can be configured as a virtual server so that remote users accessing Web
or FTP services via the public IP address can be automatically redirected to local servers
in the LAN (Loca Area Network). The DI-704UP firewall feature filters out unrecognized
packets to protect your LAN network so all computers networked with the DI-704UP are
invisible to the outside world. If public access is desired, you can make some of the LAN
computers accessible from the Internet by enabling Virtual Server. Depending on the
requested service, the DI-704UP redirects the external service request to the appropriate
server within the LAN network.
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Using the Configuration Menu (continued)

Advanced > Virtual Server

The DI-704UP is aso capable of port-redirection meaning incoming traffic to a particular
port can be redirected to a different port on the server computer. Each of the virtual
services that are created will be listed at the bottom of the screen in the Virtual Servers
List. There are already pre-defined virtual services already in the table. You may use
them by enabling them and assigning the server IP to use that particular virtual service.

Name:
The name referencing the virtual service.

Private I P:
The server computer in the LAN (Local Area Network) that will be providing the virtual
services.

Private Port:
The port number of the service used by the Private IP computer.

Protocol Type:
The protocol used for the virtual service.

Public Port:
The port number on the WAN side that will be used to access the virtual service.

Schedule:

The schedule of time when the virtual service will be enabled. The schedule may be
set to Always, which will allow the particular service to always be enabled. If it is set
to Time, select the time frame for the service to be enabled. If the system time is
outside of the scheduled time, the service will be disabled.

Example #1.

If you have a Web server that you wanted Internet users to access at all times, you
would need to enable it. Web (HTTP) server is on LAN (Local Area Network) computer
192.168.0.25. HTTP uses port 80, TCP.

Name: Web Server
Private IP: 192.168.0.25
Protocol Type: TCP
Private Port: 80

Public Port: 80
Schedule: always
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Using the Configuration Menu (continued)

Advanced > Virtual Server

Virtual Servers List
Mame Private IP Protocol Schedule
. “irttual Server HTTR 192.168.0.25 TCP E0/20 always L4l

Click on this icon to edit the virtual service.

‘I " . - . .
i ll Click on this icon to delete the virtual service.

Example #2:

If you have an FTP server that you wanted Internet users to access by WAN port 2100
and only during the weekends, you would need to enable it as such. FTP server is on
LAN computer 192.168.0.30. FTP uses port 21, TCP.

Name: FTP Server

Private IP: 192.168.0.30

Protocol Type: TCP

Private Port: 21

Public Port: 2100

Schedule: From: 01:00AM to 01:00AM, Sat to Sun

 All Internet users who want to access this FTP Server must connect to it from port

2100. This is an example of port redirection and can be useful in cases where there
are many of the same servers on the LAN network.
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Using the Configuration Menu (continued)

Advanced > Application

D-Link

Bulidmyg Networks for People DI_704U P
Ethernet Broadband Router

LI Advanced RIS Status Help
! Special Application
Special Application is used to run applications that require multiple connections.
' © Enabled O Disabled
Marme | |
Trigger Port | |
Trigger Type |TCP—v|
ApplicEsion Public Ports | |
T Fuhblic Type |IEP_.:.i
- VI I+
Apply Cancel Help
e pecial Application List
Mame Trigger Fuhlic Port
Battle.net B112 Fi112 [
- Dialpad 7175 51200-51201,51210 ]
— cul w18 205 20602085 30103000 A1
ySNGamING 47524 2300-2400,28800- 23000 AT
F O PC-to-Phone 12053 12120,12122,24150-24220 [ i
Quick Time 554 £870-6994 R

Some applications require multiple connections, such as Internet gaming, video
conferencing, and Internet telephony. These applications have difficulty working through
NAT (Network Address Translation). Special Applications makes some of these
applications work with the DI-704UP. If you need to run applications that require multiple
connections, specify the port normally associated with an application in the Trigger
Ports field, then enter the public ports associated with the trigger port into the Public
Portsfield.
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Using the Configuration Menu (continued)

Advanced > Application

At the bottom of the screen, there are defined special applications. To use them, select
one from the drop down list and select an ID number you want to use. Then click the
“Copy to” button and the router will fill in the appropriate information to the list. You will
then need to enable the service. If the mechanism of Special Applications fails to make
an application work, try using DMZ host instead.

Note! Only one PC can use each Special Application tunnel.

Enable / Disable:
Select to activate the policy. To disable the virtual server feature, select disable.

Trigger Port:
This is the port used to trigger the application. It can be either a single port or a range of
ports.

Trigger Type:
Select the trigger protocol you would like to initiate. To change the selection, use the
drop down arrow and other choices will be listed.

Public Ports:

Enter in the public port or ports to be used. A range of ports can be specified with a
hyphen.

Public Type:

Enter in the protocol type for public ports to access. To change the selection, use the
drop down arrow and other choices will be listed.

Special Application List:

In the Special Application List, it will list some of the popular services with its trigger
ports. This is the port number on the WAN side that will be used to access the application.
You may define a single port or a range of ports. You can use a comma to add multiple
ports or port ranges.
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Using the Configuration Menu (continued)
Advanced > IP Filter

D-Link
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DI-704UP

Virtual Server

—

—

Application

Filter

Firewall

SNMP

DDNS

Routing

Ll i

DMz

Use IP (Internet Protocol) filters to allow or deny computers access to the Internet based

on their IP address.

Ethernet Broadband Router

 Tools  Status

LI Advanced

Filter

Filters are used to allow or deny LAN users from accessing the Internet.
@ IP Filters OURL Blocking
O MAC Filters O Domain Blocking

IP Filter

Use IP Filters to deny LAN IP addresses access to the Internet.

O Enabled O Disabled

IP Address | || |
PortRange | || |
Pratocol !_T_CM
Schedule O Always
O From Time|UU VHUU V'T0|UU V|:|UU V|
(VIR +
Apply Cancel Help
IP Filter List
IP Range FProtacal Schedule
. TCP 20-21 always ]
. TCP 80 always ER]
¥ TCP 443 always |
* UDP 53 always B El[
. TCP 25 always R}
* TSR 110 always ER]
- TCP 23 always AT




Using the Configuration Menu (continued)
Advanced > IP Filter
D-Link

iamsm fetvars o oy DI-704UP

Ethernet Broadband Router

[ Home WY IETTTTN " Tools Status Help

Filters are used to allow or deny LAN users from accessing the Internst.
@ PFiters O URL Blocking
O macFiiters O Domain Blocking

Virtual Server

IP Filter
Use IP Filters to deny LAN IP addresses access tothe Intemet

Application

.
o

O Enabled O Disabled
P Address | [ |

Filter

Port Range [ |-[

P Protocal [Tep v
Firewall R
Sehedule © Atways
M —
© Fom  Timeo0 %} 00 fro [ ]
daylSun s ]
9 90
Apply Cancel Help
—
Routing
> Filter List
,— IP Range Pratocol Schedule
bmz - TOP 20-21 always [Ed]
TCP 80 always )]
TOP 443 always R
UDF 53 atways EL]
TGP 25 always @i
TCR110 always [EX]
TCP 23 always @i

Enabled / Disabled:
Click Enabled to apply the filter policy or click Disabled to enter an inactive filter policy
(You can reactivate the policy later.)

IP Address:

Enter in the IP address range of the computers that you want the policy to apply to. If it
is only a single computer that you want the policy applied to, then enter the IP address of
that computer in the Start Source IP and leave the End Source IP blank.

Port Ranges:

Enter in the port range of the TCP/UDP ports that you want the policy to apply to. If itis
only a single port that you want the policy applied to, then enter the port number in the
Start Port field and leave the End Port field blank. |f you want to use all the ports, you can
leave the port range empty.

Protocol:
Select the protocol type to block certain 1P addresses.

Schedule:
Select Always, or choose From and enter the time period during which the IP filter policy
will bein effect.

36



Using the Configuration Menu (continued)
Advanced > MAC Filters

D-Link
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[ Home WEUYTTTHE Tools  Status Help

Filters are used to allow or deny LAN users from accessing the Internet.
O IP Filters O URL Blocking
@ MAC Filters O Domain Blocking

MAC Filters

Virtual Server
Use MAC address to allow or deny computers access to the netwark,

il 4

Ll L () Disabled MAC Fillers

) Cnlyallow computers with MAC address listed below to access the netwark

Fiter () Cnly deny computers with MAC address listed below to access the netwark
o
Firewall Narme | |

macagdess| [ [ [ [ W[ ]
i DHCP Client |- select one v

bons @ & 0O

Apply Cancel Help

Routing MAC Eiltar
Marme MAC Address

Ll

N

MAC (Media Access Control) Filters are used to allow or deny LAN (Local Area Network)
computers from accessing the Internet and network by their MAC address.

At the bottom of the screen, there is a list of MAC addresses from the DHCP client
computers connected to the DI-704UP. To use them, select one from the drop down list
and select an IP number you want to use. Then click the “Copy to” button and the DI-
704UP will fill in the appropriate information to the list.
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Using the Configuration Menu (continued)
Advanced > MAC Filters

Disabled MAC Filter:
Select this option if you do not want to use MAC filters on your Local Area Network
(LAN).

Only allow computers with MAC address listed below to access the
network:

Select this option to allow only computers that are in the list access to the network
and Internet. All other computers will be denied access to the network and Internet.

Only deny computers with MAC address listed below to access the
network:

Select this option to deny only computers that are in the list access to the network
and Internet. All other computers will be allowed access to the network and Internet.

Name:
Enter the Name to create a profile for the associated computer(s) on the network.

MAC Address:
Enter the MAC Address of the client that will be filtered.

DHCP Client:
Select from the DHCP Client list and click the Clone button to automatically clone that
computer’s MAC address to the MAC address field.
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Using the Configuration Menu (continued)
Advanced > URL Blocking

D-Link

Bulkimg Networks for People DI_704U P
Ethernet Broadband Router

ST Advanced RETIE Status  Help

riter
Filters are used to allow ar deny LAN users from accessing the Internet.
= - OIPFilters & URL Blocking

(O MAC Filters © Domain Blocking

[ s o
Virtual Server URL Blocking
Block those URLs which contain kevwords listed below:,
| i
O Enabled @ Disabled

Filter | |
- - Empty -
I Firewall

SNMP

Bovis 2 © O
Apply Cancel Help
Routing

IAEE

DMZ

Use URL Blocking filters to disallow computer(s) to access Internet with the following
URL keywords entered into the list. The URL Blocking filters are useful features that are
similar to parental control. Users can enter keywords that may have adult content,
hack, or other materials to prevent computers connected to the Local Area Network
(LAN) from accessing those web sites.
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Using the Configuration Menu (continued)

Advanced > Domain Filter

D-Link

Bulkdmg Metworks for People D|-704U P

Ethernet Broadband Router
QLI Advanced  Status  Help

‘Tools
v =
Filters are used to allow or deny LAN users from accessing the Internet.
O IP Filters O URL Blocking
(O MAC Filters @& Damain Blacking

Virtual Server Domain Blocking
@) Disabled
Application ) Allow users to access all domains except"Blocked Domains®.

) Deny users to access all domains except"Permitted Domains”.

Filter
Permitted Domains
e
Firewall |
- Empty -

" snme
# 1

DDNS Blocked Do
, 1
I Routing - Empty -
—

DMZ

@ 9O

Apply Cancel Help

Use Domain filters to allow or deny computers access to specific Internet domains
whether it is through www, ftp, snmp, etc. Domain filters apply to wired computers
connected to one of the four Ethernet LAN ports to the DI-704UP.
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Using the Configuration Menu (continued)

Advanced > Domain Filter

Disabled Domain Filter:
Select this option if you do not want to use Domain filters.

Allow users to access the following domains and block all other domains:
Select this option to allow users to access the specified Internet domains listed below.
Users will be denied access to all other Internet domains.

Deny users to access the following domains and permit all other domains:
Select this option to deny users to access the specified Internet domains listed below.
Users will be allowed access to al other Internet domains.

Permitted Domains:
Enter in the domain suffix of the Internet domain you want to use.
(Example: shopping.com, sports.net.)

Blocked Domains:
Enter in the domain suffix of the Internet domain you want to block.
(Example: shopping.com, sports.net.)

Delete:

Select this option to remove the domain suffix from the Permitted Domains or Blocked
Domains list.
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Using the Configuration Menu (continued)

Advanced > Firewall
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Ethernet Broadband Router

| Home WFUIPTTETE Tools  Status Help

? -Fi.r’E\n\.r:a.II\ R.ul:aé.c.;an be usedto allow or deny trafiic from passing through the DI-704LUP.
O Enabled O Disabled

Mame [

Action O alow O Deny
Interface  IP Start IP End Protocol  PortRange

- Source | ¥ | | | |

Destination |+ »| | | | | [1er ] | H |

Filter Schedule O Always

I
O From  Time 00 v[{00 ¥[Tg[00 ¥ {00 v
Firewall — = [

SNMP . o 3 o

Apply Cancel Help

——
DDNS e
Action Mame Source Destination Protocol
I Routing Allow Allow 1o Ping WAN port  YWAN,” LAN,192.168.0.1 ICMP,* (4T
s LAN,- . AR
Deny Default % 192 168.04 5 Lé'[ﬁ
e Allow Default LAN* *192188.01 %7 EX|

Firewall Rules is an advanced feature used to allow or deny traffic from passing through
the Broadband Router. It works in the same way as IP Filters with additional settings.
You can create more detailed access rules for the DI-704UP. When virtual services are
created and enabled, it will also display in Firewall Rules. Firewall Rules contains all
network firewall rules pertaining to IP (Internet Protocal).

In the Firewall Rules List at the bottom of the screen, the priorities of the rules are
from top (highest priority) to bottom (lowest priority.)

Note: The DI-704UP MAC Address filtering rules have precedence over the Firewall
Rules.
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Using the Configuration Menu (continued)
Advanced > SNMP
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QLT Advanced RCTE Status = Help

SNMP
Q Use Simple Netwark Management Protacal{SMMP) for D-704UP management purposes.
SNMP Local @ Enahled O Disabled
: SNMP Rermote O Enanled @ Disabled
e o EHER e TEEEE
Virtual Server Gat Cammunity |pubh|: |
Set Cammunity private
= S ———
| |
Filter —
IP3 [ |
o L ]
Firewall P4
SHIMP Version Owv Ovie
SNMP
<+
F
e
DDNS Apply Cancel Help

Routing

il

DMZ

SNMP (Simple Network Management Protocol) is a widely used network monitoring and
control protocol that reports activity on each network device to the administrator of the
network. SNMP can be used to monitor traffic and statistics of the DI-704UP. The DI-
704UP supports SNMP v1.

Enabled or Disabled:
Click Enabled to enable SNMP. Click Disabled to de-activate SNMP.

Local:
SNMP services will be available on the Local (LAN) network.

Remote:
SNMP services will be available on the remote (WAN) network.

Get Community:
“Read only” access for network administration using SNMP.  You can view the network,
but no configuration is possible with this setting.

Set Community:

“Read and Write” access for network administration using SNMP.  The administrator can
configure the network with this setting.
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Using the Configuration Menu (continued)
Advanced > DDNS
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LI Advanced T Status Help
Dynamic DNS
¢ Use Dynamic DNS if you want to use your DDMNE account.
DDNg @ Disabled O Enabled
Provider [oynons orgoynaric) v |
P — Reblbics: e
Virtual Server Host Name [ |
Usernarne | E-mail | |
Password Koy | |
5
9 90
§
T
Apply cancel Hebp
B
SNMP

Routing

i

DMZ

DDNS (Dynamic Domain Name System) keeps dynamic IP addresses (e.g., IP ad-
dresses assigned by a DHCP capable router or server) linked to a domain name. Users
who have a Dynamic DNS account may use this feature on the DI-704UP.

DDNS:

When an IP address is automatically assigned by a DHCP server, DDNS automatically
updates the DNS server.

Provider:
Select your provider from the pull-down menu.

Host Name:
Enter the Host name.

Username/Email:
Enter the username/email address.

Password/Key:
Enter the password/key.
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Using the Configuration Menu (continued)
Advanced > Routing
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[ Home W UIZYITTR Tools  Status Help

Routing Table
Q Usethe houting Table for routing purposes within your local netwark,
Dynamic Routing & Disable O RIPY O RIPY2
D  Destination Subnet Mask Gateway Hop Enable
T I 510 | 4]
e
3| [ 4 | il o
e
[ N (e (N — i
5 i Il il | ]
—_—
s ) i
= = — &5 s
g i 1 IRl | ]
w0
Routing Apply Cancel Help

DMz

Static routes can be added if you require specific routes within your internal network.
These routes will not apply to the WAN network.

Destination:

Enter in the IP of the specified network that you want to access using the static route.

Subnet Mask:
Enter in the subnet mask to be used for the specified network.

Gateway:

Enter in the gateway |IP address to the specified network.

Hop:

Enter in the amount of hops it will take to reach the specified network.

Enable:
Select this option for the specified static route to take effect.

Hop Count - in a transmission path, each link is terminated at a network device
such as a router or gateway. The number of hops equals the number of routers or

gateways that data must pass through before reaching the destination.
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Using the Configuration Menu (continued)
Advanced > DMZ
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| Home WUIPTTFTE Tools  Status Help

DMZiDemilitarized Zone) is used to allow a single computer on the LAN to be exposed to
the Internet.

CiEnabled @ Disabled

Virtual Server IP Address 192168.0, |

Npplicntinn a g o
Apply Cancel Help
Filter

il
|
R
—

Firewall

i

I DDNS

i

Routing

DMz

If you have a computer that cannot run Internet applications properly from behind the
DI-704UP, then you can allow that computer to have unrestricted Internet access. En-
able this feature and enter the IP address of that computer as a DMZ (Demilitarized
Zone) host with unrestricted Internet access. Adding a client to the DMZ may expose
that computer to a variety of security risks; so only use this option as a last resort.
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Using the Configuration Menu (continued)
Tools > Admin
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| Home Advanced Tools Status  Help

inistrator Setting

Administrators can change their login password.

Adrinistrator (The Login Mame is "admin®

Admin Reconfirm Pagsword |

Time User (The Login name is "user")
Mew Passwordl ........
System Feconfirm Password |sesesess |

{ils

Firmware

rm administration task from remote host.

[

Misc (O Enabled & Disabled
IP Address [0.0.0.0 i

Port [a0en |

990

Apply Cancel Help

Administrator Settings

At this page, the DI-704UP administrator can change the system password. There are
two accounts that can access the Broadband Router's Web-Management interface.
They are admin and user. Admin has read/write access while user has read-only access.
User can only view the settings but cannot make any changes.
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Using the Configuration Menu (continued)
Tools > Admin

Remote Management:

Remote Management allows the DI-704UP to be configured from the Internet by a web
browser. A username and password is still required to access the Web-Management
interface. In general, only a member of your network can browse the built-in web pages
to perform “Administrator” tasks. This feature enables you to perform “Administrator”
tasks from the remote (Internet) host.

IP Address:

Internet IP address of the computer that has access to the Broadband Router. It is not
recommended that you set the IP address to 0.0.0.0, because this allows any Internet
IP address to access the Broadband Router, which could result in aloss of security
for your network. If you elect to Enable Remote Management, enter the IP Address of
your remote location.

Port:
Select the port number used to access the Broadband Router.

Example: http://x.x.x.x:8080 whereas x.x.x.x is the WAN IP address of the Broadband
Router and 8080 is the port used for the Web-Management interface.

Tools > Time

D-Link

Ul Networks for People DI-704UP
Ethernet Broadband Router

Home —Advanced [ LS Status —Heln |

Setthe DFTI4UR system time.
Device Time : Fri-Jul 04 00.05:05 2003
@) Enable NTP
Default NTF Server | foptionan
Admin Time Zone | (GMT-08-00)Pacific Time (US & Canada) ~

A

Time () set Device Date and Time

Year[2003 %] wontn[44 | pay[o4 ¥

Hour: 00 %] Minuts: 00 | Second:[00 |

2 OO
Cancel !

=] =

The system time is the time used by the DI-704UP for scheduling services. You can
manually set the time or connect to a NTP (Network Time Protocol) server. If an NTP
server is set, you will only need to set the time zone.
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Using the Configuration Menu (continued)
Tools > System
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System Settings
Q Save Settings To Local Hard Drive
Admin Load Settings From Local Hard Drive
|(Browse__|
e

Time

Restore To Factory Default Settings
system
Firmwar O

Help

i

Misc

The current system settings can be saved as a file onto the local hard drive. The saved
file or any other saved setting file created by the DI-704UP can be uploaded into the unit.
To reload a system settings file, click on Browse to search the local hard drive for the
file to be used. The device can also be reset back to factory default settings by clicking
on the Reset to Default button. Use the restore feature only if necessary. This will erase
previously saved settings for the unit. Make sure to save your system settings to the
hard drive before doing a factory restore.

Save Settings to Local Hard Drive:
Click Save to save the current settings to the local Hard Drive.

Load Settings from Local Hard Drive:
Click Browse to find the settings file, then click Load.

Restore to Factory Default Settings:
Click Reset to Default to restore the factory default settings.
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Using the Configuration Menu (continued)
Tools > Firmware
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There may be new firmware for your DI-704UP to improve functionality and perfarmance
Click here to check for an upgrade on our support site.

The upgrade procedure takes about 20 seconds. Notel Do not power off the unitwhen itis
being upgraded. When the upgrade is done successtully, the unitwill be restarted
Admin automatically.

Current Firmware Version: V1.00
Time Firmware Date: Fri, Jul 4 2003

| |[(Bromse... ]

o 4

System

Firmware a 3 o
Apply Cancel Help
=

You can upgrade the firmware by using this tool. First, check the D-Link support site for
firmware updates at http://support.dlink.com. Make sure that the firmware you want to
use is saved on the local hard drive of your computer. Click on Browse to search the
local hard drive for the firmware that you downloaded from the D-Link website to be used
for the update. Upgrading the firmware will not change any of your system settings but
itis recommended that you save your system settings before doing a firmware upgrade.

Browse:

After you have downloaded the new firmware, click Browse in this window to locate the
firmware update on your hard drive. Click Apply to complete the firmware upgrade.

Note! Do not power off the unit when it is being upgraded. When the
upgrade is complete, the unit will be restarted automatically.
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Using the Configuration Menu (continued)

Tools > Misc

D-Link

Buldmg Networks for People

F

DI-704UP
Ethernet Broadband Router

. Gl Tools Status

Ping Test-is used to send "Ping" packets to testif a computer is on the Internet.

Host Mame or IF address |

Restar

Reboots the DI-704LUP.

Block WAN 1

When you "Block YWAR Ping”, you are causing the puhlic WaAN IP address on the DI-704UF to not
respond to ping commands. Pinging puhblic YWAN IP addresses is a commaon method used by
hackers to test whether your WAN IP address is valid.

Discard PING from YWaN side O Enabled & Disabled

You can setup this item ifyou want to enahle SPImode.

O Enabled & Disakled

Setting
tting

You can disable or enable UPKP functions at anytime.

@ Enabled O Disabled

VPN Pass-Thr ih

Allovs WP connec'iions towork through the DI-704UP,

PPTF & Enabled O Disabled
IPSec @ Enabled O Disabled

FTP port

MNan .ot

You have to setup this item if you wantto access an FTP sererwhose port number is not 21.

Port | |

I+

Apply Cancel Help
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Using the Configuration Menu (continued)
Tools > Misc

Ping Test:
This diagnostic utility can be used to check if a computer is on the Internet. It sends
ping packets and listens for replies from the specific host.

Reboot:
Click Reboot to restart the unit.

Block WAN Ping:
Click Enable to block the WAN ping. Computers on the Internet will not get a reply back
from the DI-704UP when it is being “ping”ed. This may help to increase security.

SPI Mode:

Stateful Packet Inspection is a form of firewall protection that will inspect all of the pack-
ets transmitted through the DI-704UP. It carefully inspects all incoming packets and if the
packets contain suspicious information, it will automatically drop those packets.

UPNnP Setting:

Universal Plug and Play is a feature that is preset to allow certain popular applications
such as MSN messenger to be functional using the router without making any configura-
tions. By default, theUPnP Setting is set to enable. It is recommended to keep the UPnP
Setting on enable.

VPN Pass Through:
For users who telecommute or use Virtual Private Network (VPN), you can select PPTP
or IPSec to be used with this router.

Non-standard FTP port:
If an FTP server you want to access is not using the standard port 21, then enter in the

port number that the FTP server is using instead.
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Using the Configuration Menu (continued)
Status > Device Info

D-Link

Buldmg Networks for People

DI-704UP
Ethernet Broadband Router

Home Advanced Tools Status -m

: Firmware Version: VV1.00, Fri, Jul 4 2003
= LAN
MAC Address 00-40-05-48-E3-61
IP Address 192.168.0.1
Device Info Subnet Mask 255 255 25500
DHCP Server Enabled

Log
WAN

_____
- MAC Address 00-40-05-48-E3-60
. DHCP Client Disconnected.

Conr [ ohePrerew | [ DHCP Relesse |

Remaining Lease Time 00:00:00
IP Address 0.0.0.0
Subnet Mask 0.0.0.0
Gateway 0.0.0.0
Domain Name Server 0.0.0.0

Peripheral
Printer Mot ready

Device Time: Fri Jul 04 00:08:18 2003

Help

This page in the Configuration Utility displays the current information for the Broadband
Router. It will display the WAN, LAN, and MAC address information. If your WAN
connection is set up for Dynamic IP address a Release button and Renew button
will be displayed. Use Release to disconnect from your ISP and use Renew to connect
to your ISP. If your WAN connection is set up for PPPoE, a Connect button and
Disconnect button will be displayed. Use Disconnect to drop the PPPoE connection
and use Connect to establish the PPPoE connection. This page allows you to observe

the DI-704UP’s working status:
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Using the Configuration Menu (continued)

Status > Device Info

LAN
LAN MAC Address:
Displays the LAN port MAC/hardware address.

IP Address:
LAN/Private IP Address of the DI-704UP.

Subnet Mask:
LAN/Private Subnet Mask of the DI-704UP.

WAN
WAN MAC Address:
Displays the WAN port MAC/hardware address.

IP Address:
WAN/Public IP Address.

Subnet Mask:
WAN/Public Subnet Mask.

Gateway:
WAN/Public Gateway IP Address.

Domain Name Server:
WANY/Public DNS IP Address.

PeripheralPrinter:
Status of the USB print server port.
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Using the Configuration Menu (continued)
Status > Log

D-Link

Bulkimg Networks for People

DI-704UP
Ethernet Broadband Router

Home Advanced Tools Status m

? Wiew Log dlaplays the activities occurring on the DI-704UP. Click on Log Settings for advance
S features

R s o
Device Info Help
Page 173
L
v WAN Ty’ Dynarnic IP Address (1 00

Display time: Fri Jul 04 00:09:04 2003

—

Stats

Friday, July 04, 2003 12:00:04 AM DODtriggered internally
Friday, July 04, 2003 12:00:04 AM DHCP: discover)
Friday, July 04, 2003 12:00:08 AM DHCP: discover()
Friday, July 04, 2003 12:00:16 AM DHCP:discover)
Friday, July 04, 2003 12:00:32 AM DHCP discover()
Friday, July 04, 2003 12:01.07 AM DOD triggered internally
Friday, July 04, 2003 12:01.07 AM DHCP discover()
Friday, July 04, 2003 12:01:11 AM DHCP: discoverd
Friday, July 04, 2003 12:01:19 AM DHCP: discoverd
Friday, July 04, 2003 12:01:35 AM DHCP discover)

The Broadband Router keeps a running log of events and activities occurring on the
router. If the device is rebooted, the logs are automatically cleared. You may save the
log files under Log Settings.

First Page:
The first page of the log.

Last Page:
The last page of the log.

Previous:
Moves back one log page.

Next:
Moves forward one log page.

Clear:
Clears the logs completely.

Log Settings:
Brings up the page to configure the logs.
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Using the Configuration Menu (continued)
Status > Log Settings

D-Link

Buliing Networks 1or Peaple

DI-704UP
Ethernet Broadband Router

Home Advanced Tools Status m
s

Log Setting
Logscanh
= E-mail Alert

SMTP Servar [ IP Address | |

T ) .
Ernail Address | | [[_sene Mail How

Syslog

15
saved by sending itto an admin email address orto a syslog server,

L Syslog Server IP Address 1932.168.0 | © Enabled @ Disabled

Loo Type (] Systern Activity

og
| Stats [Fl Debuy Information

[ attacks
Dropped Packets
[l Motice

@ © 0O

Apply Cancel Help

Log Settings
Displays the logs of activities and events, and can be setup to send these logs to
another location.

E-Mail Alert:
The DI-704UP can be set up to send the log files to a specific email address.

SMTP Server IP:

Input the SMTP information. Usually, this is provided by your Internet Service Provider
(ISP).

Send E-Mail alert to:
Enter in the email address of the recipient who will receive the email log.

Send Mail Now:
Click to send mail now.
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Using the Configuration Menu (continued)
Help

D-Link

Bulimyg Metworks for Peopie DI_704U P
Ethernet Broadband Router
Home Advanced Tools Status Help
Home
; » Setup Wizard
o AN Settings
. o LAMN Settings
» DHCP Server
» VPN
Advanced

« Virual Server

= Special Applications
Filters

Firewall Rules
ShIMP

DONE

Routing

DMz

Tools
» Administrator Settings
» System Time
» System Settings
» Firmwware Upgrade
+ Miscellaneous ltems

Status

e Device Information
« Log
e Traffic Statistics

FAQs

Help
This menu displays the complete Help menu. For help at anytime, click on the Help tab
in the configuration menu.
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Installing the Print Server Software

Insert the installation CD-ROM into the CD-ROM drive. The following window will be
shown automatically. If it is not, please run “install.exe” on the CD-ROM.

+D-Link DI-704UP

Building Networks for People

UsB
Express EtherNetwork' o o

Gables
ExDSIE
DI-704UP Ready!
ot R FOUR
Pt
- PORTS

- =)

s e

=

Click Install Print
Server Software

+ D-Link DI-704UP

Building Networks for People

DI-Z04UR

Click to Install Print
Server Software for
either Windows 98SE/ME
or Windows 2000/XP

Print Server Setup El

‘Welcome to the InstallShield Wizard for
Broadband Router Print Server

‘Wwelcome to the Broadband Router Print Server diiver
Setup program. T his program will install Print Server on your
computer.

Click Next

Cancel I

58




Installing the Print Server Software (continued)

Print Server Setup EJ

Choose Destination Location

-
Select folder where Setup will install files. = ’

Setup will install Broadband Router Print Server in the following folder.

Sel eCt the d ! natl on fOI der Toinstall to this folder, click Nest. To install to a different folder, click Browse and select
another folder.

Click Browse to
select a destination Destination Folder

fOId er CAAD-LinkMBroadband Router Print Server

Click Next

| Cancel

Print Server Setup

. InstallShield Wizard Complete

The InstallShield Wizard has successfully installed Broadband
Router Print Server. Click Finizh to exit the wizard.

Click Finish
“ou must reboot your PC for all changes to take effect.

Select the

option for

restarting the (s ez | wank to restart my compter now.;
computer.

Mo, | will restart my computer later,
Glick oK

After rebooting your computer, the software installation procedure is finished.



Installing the Print Server Software (continued)

Configuring on Windows 98SE/ME Platforms

After you finish the software installation proce-
dure, your computer will be capable of network
printing provided by the DI-704UP. On a Win-
dows 95/98 platform, open the Printers win-
dow in the My Computer menu.

Now, you can configure the print server of
the DI-704UP: Find the corresponding

ites Toos Help

| @seach Cyfades 8| B2 X o0 | E

@ = ~

Printers ~  CB0Seies

2 object(s) 7

EPS0N Stylus C60 Series Piopeities i 2]

b Pa 5 Layout | & Uty |
General Details Color Managemert | ¢ Main

icon for your printer, for example, the
Epson Stylus C60 Series. Right click on
that icon, and then select Properties.

The screen at the right will appear.

Click on the
Details tab

Choose the “D-Link LPT port (Print
Server)” from the list attached at the Print
To item. Be sure that the Printer Driver
item is configured to the correct driver of
your printer.

15 :f} EPSON Stylus CBO Series

Comment: ||

Separator page: [[none) =] Browse..

Pint Test Page

[T = =

EPSON Stylus C60 Series Properties 2l x

GMain | e Paper | laow | B oy |

General Detais Color Management | Shaiing

(% EPSON Stylus CB0 Series

Print to the following port:

D-Lirk LPT port [ Print Server] j Add Port...

Delete Patt

Mew Diiver...

Caplure Pinter Part., | End Capture..

Print using the follawing diver
DT Syl CEl Cerics

Timeout ssting

Mot selected 15 seconds
Tiansmission fetry; |45 seconds

Click Port Settings

Spac| Setlings... | |_Pat Selings. |]

0K | Cancel N
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Installing the Print Server Software (continued)

Configuring on Windows XP/2000/NT Platforms

Frinter Ppsition

Enter the Praduct's IP |

Type in the IP address of the DI-704UP. [r2e768 0.1 Cancel
Click OK
x|

' g : Color Management I Sec grsion Information |
CI I C k PO rt Benei 1 hafing Advanced
§ EPSON Stylus CEO Series

The configuration procedure for a Windows — ) Dot ot
. . . . £nnt o the following ports) ocuments will print (o the hirst ree
2000/XP platform is similar to that of Win- checked pott
[=]

Port | Dieseription | Prinker

dows 95/98 except the screen of printer Prop- e T

O cOM3:  Serial Port

erties: Ol coMé  Serisl Pan :‘

CIFILE:  Print to File
O useo.. Vitual printer port fo...  EPSON Stplus C60 Series

Lin... Local Port

Add Part... Delete Part || Configure Part, |I
——

¥ Enable hidirectional support
™ Enable printer pooling

Click Configure Port

oK I Cancel Apply

Frinter Position

Type in the IP address of the

DI-704UP. Enter the Product's [P : |
[192.168. 01 Cancel
Click OK

(Note: Screen shots are taken in Windows 2000, similar
screens will appear in Windows XP.)
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Networking Basics
Using the Network Setup Wizard in Windows XP

In this section you will learn how to establish a network at home or work,
using Microsoft Windows XP.

Note: Please refer to websites such as http://www.homenethelp.com
and http://www.microsoft.com/windows2000 for information about
networking computers using Windows 2000, ME or 98SE.

Go to Start>Control Panel>Network Connections
Select Set up a home or small office network

Network Setup Wizard

Welcome to the Network Setup
% wWizard

Thiz wizard will help vou zet up thiz computer to run on your
nietwark, Wit a network you can:

Share an Intermet connection

Set up Internet Connection Firewall
Share filez and folders

Share a printer

L I |

Ta continue, click Mest.

[ Cancel

To continue, click Next.
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Networking Basics (continued)
Using the Network Setup Wizard in Windows XP

Please follow all the instructions in this window:

Metwork Setup Wizard
Before you continue._.

Before you continue, review the shecklist for sreating & networs.

Then, complete the following steps:

+ |nstall the netwaork cards, modems, and cables.
+ Tum on all computers, printers, and external modems.
+ Connect ta the Intemet.

When pou click Nest, the wizard will search for a shared Intemet cohtection on your network.

< Back l Ment » ' Cancel

Click Next

In the following window, select the best description of your computer. If your

computer connects to the Internet through a gateway/router, select the
second option as shown.

Network Setup Wizard
Select a connection method.

Select the statement that best dezcribes this computer:

() This computer connects directly ta the Internet. The ather computers on my network connect
to the Intemet through this computer,

“iew an example.

(®) This computer connects ta the Intemet through anather computer on my netwark. ar thraugh
a rezidential gateway.
igw an example,

Learn maore about harme or small office netwaork confiqurations.

< Back [[ Mest » “I[ Cancel

Click Next
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Networking Basics (continued)
Using the Network Setup Wizard in Windows XP

Enter a Computer description and a Computer name (optional.)
Network Setup Wizard

Give this computer a description and name.

[Qornpuler description: | fary's Computer |]

Examplzs: Family Room Computer or Monica's Compter

[Egrnpuler NAamme: | Cffice | ]
Examples: FomILT of MONICE

The current computer name iz Office

Learn more about computer names and descriptions.

< Back l et > | Caticel

Click Next

Enter a Workgroup name. All computers on your network should have the
same Workgroup name.

Network Setup Wizard

Hame your network.

Mame your network, by specifying a workgroup name below. All computers on your network
should have the same work group name.

‘whorkgroup name: Accounting
Examples: HOME or OFFICE

[ < Back | Neut: ]’ Cancel J

Click Next
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Networking Basics (continued)
Using the Network Setup Wizard in Windows XP

Please wait while the Network Setup Wizard applies the changes.

Network Setup Wizard

Ready to apply network settings. .

The wizard will apply the following settings. This process may take a few minutes to complete
and cannot be intermupted,

Settings:
Metwark settings: ~
Computer description: Mary's Computer
Computer name: Cffice
whark group name: Accounting
The Shared Documents folder and any printers connected ta this computer have been
shared.
M

To apply these settings. click Mext.

[ ¢ Back [[ Mest > I[ Cancel

——

When the changes are complete, click Next.

Please wait while the Network Setup Wizard configures the computer.
This may take a few minutes.

Metwork Setup Wizard

Please wait...

Please wait while the wizard configures this computer for hame or small office networking. This
pracess may take a few minutes.

. o5
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Networking Basics (continued)
Using the Network Setup Wizard in Windows XP

In the window below, select the option that fits your needs. In this example, Create a

Network Setup Disk has been selected. You will run this disk on each of the

computers on your network. Click Next.

Network Setup Wizard

You're almost done...

the Windows =P CD or a Metwork Setup Disk.

“what do you want to do?

(®iCreate a Netwark Setup Diski

(0 Use the Netwark Setup Disk | already have
(D) Use my Windaws XP CD

() Just finigh the wizard; | don't need o run the wizard on other computers

(.

2 Tou need to run the Metwork Setup Wizard once on each of the computers on your
\l‘) network. To run the wizard on computers that are not rnning Windows %P, pou can uze

Insert a disk into the Floppy Disk Drive, in this case, drive A.

Network Setup Wizard

Insert the disk you want to use.

Ingert a dizk the into the following dizk diive, and then click Mest.

3% Floppy [&:]

If pou want to format the disk, click Format Disk.

Format the disk if you wish, and click Next.
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Networking Basics (continued)
Using the Network Setup Wizard in Windows XP

Please wait while the Network Setup Wizard copies the files.

Please wait while the wizard copies Files. ..

[ ]| Zancel |

Please read the information under Here’s how in the screen below. After you com-
plete the Network Setup Wizard you will use the Network Setup Disk to run the

Network Setup Wizard once on each of the computers on your network.

Network Setup Wizard
To run the wizard with the Network Setup Disk. ..

® . Complete the wizard and restart thiz computer. Then, use the Mebwaork, Setup Dizk to run
\!‘) the Metwork, Setup Wizard once on each of the other computers on pour network.

Here's how:
1. Inzert the Metwark, Setup Dizk into the nexst computer pou want o netwark,

2. Open My Computer and then open the Metwork, Setup Disk.
3. Double-click "netzetup."

< Back IL Mewt s

To continue, click Next.
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Networking Basics (Continued) _
Using the Network Setup Wizard in Windows XP

Please read the information on this screen, then click Finish to complete the
Network Setup Wizard.

Network Setup Wizard

Completing the Network Setup
% Wizard

You have successfully set up thiz computer far home ar zmall
office networking.

For help with home or small office netwaorking, zee the
follawing topics in Help and Support Center:

+ Lzing the Shared Documents folder
+ Shanng hles and folders

To zee ather computers an yaur network, click Start, and then
click My Metwaork, Places,

To cloze thiz wizard, click Finish.

e ——
| <Back || Finish |
\—

The new settings will take effect when you restart the computer. Click Yes to
restart the computer.

System Settings Change X

P You mustk restart vour compuker before the new settings will take effect,
</

Do wou want bo reskart your computer now?

You have completed configuring this computer. Next, you will need to run the
Network Setup Disk on all the other computers on your network. After run-
ning the Network Setup Disk on all your computers, your new network will be
ready to use.
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Networking Basics (Continued)

Naming your Computer

To name yo%r computer, please follow these directions: In Windows XP:
Click Start (in the lower left corner of the screen)
B Right-click on My Computer

B SelectProperties

“ Internet __J My Documents
Internet Explaorer
&I E-mail b My Recent Documents

d Cutlook Express

ﬁ} My Pictures

n Command Prompk j My Music

=
“ M3 Explorer |‘I “y Computer |
'\ Open

g My Network  Explore
® ‘windows Media Player

Search...

‘ & Control Panel|  Manags
WL, tindows Movie Maker

Map Metwork Drive. ..
e_; Connect To Disconnect Metwark Drive. ..

'.@ Tour Windows KP =
}‘-ﬂ. Printers and ' Show on Desktop

4 | Files and Settings Transfer ~ Rename
Wizard @) Help and Su@‘

B Select the Computer
Name Tab in the System
Properties window. | SystemRestge_|__éuiomatic Updates | Remote |

| General ] Hardware | Advanced |

System Properties

windows uzes the following information to identify pour computer
on the network,

B Entera Computer De- Computer description:
Scrlptlon; this field is For exampls; "Kitchen Computer” or "Mary's
optional. Computer".
Full computer name:  Office
“Waorkgroup: Accounting

T uze the Metwark [dentification wizard ta join a
[ ] To rename the Computer or domain and create a local uzer account, click Metwork ook i
. . . 10,
join a domain, Click

Chang e To rename this computer or join a domain, click Change. -
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Networking Basics (Continued)
Naming your Computer

B In this window, enter the Computer Name Changes
Com p uter name. r'ou zan change the name and the membership of this
computer. Changes may affect access o network resources.

B Select Workgroup and enter
the name of the Workgroup. Computer name:
| Office |

B All computers on your network | g comnuter name:
must have the same Office
Workgroup name.

Mare. .

B Click OK. tember of
() Daomair;

() Workgroup:
| Accounting |

I oK l[ Canhicel ]

Assigning a Static IP Address in Windows XP/2000

Note: Residential Gateways/Broadband Routers will automatically assign IP Ad-
dresses to the computers on the network, using DHCP (Dynamic Host Configura-
tion Protocol) technology. If you are using a DHCP-capable Gateway/Router you
will not need to assign Static IP Addresses.

If you are not using a DHCP capable Gateway/Router or you need to assign a Static IP
Address, please follow these instructions:

- !_—- Control Panel
I@ Tour Windows XP

| Go to Start. =
.@ Printers and Faxes

\| Files and Settings Transfer
s Wvizard

1 g Help and Support;

Paink

i : {7 secrch

B Double-clickon y-) Bare
Control Panel.

all Programs D =] Run...




Networking Basics (Continued)
Assigning a Static IP Address in Windows XP/2000

B Control Panel

File:

O Back. -\) I, )'T) Search

Address E} Control Panel

Edit  Wiew Favortes  Tools  Help

Control Panel A
. . £ )Add or Remove Programs
Network :

Connections.

See Also

% Windows Update
@) Help and Suppart

& Game Controllers
’Intemet Ciptions

= Phone and Modem Cptions
ower Optians
~aPrinters and Faxes
9 Regional and Language Options
= Scanners and Cameras
=) Scheduled Tasks
), sounds and Audio Devices

i Taskbar and Start Menu
User Accounts

iy Start

"s Network Connections

File Edit Wew Favorites Tools  Advanced  Help

eBack - Q L} pSearch || Felders

& Network Cannections

A Name
Network Tasks LAN or High-Speed Internet

[ Create anew
cannection
H H D Set b il
B Right-click on Local Area i~
@ Disable this network

Connections. donce
&, Repair this connection
®fi Rename this connection
&) Visw status of this
connection

Change settings of this
connection

Disable
Status
Repair

Bridge Connections
Create Shortcut
Delete
Rename

Properties

B Single-click on
PrOpertleS. Other Places
[ contral Panel i
& My Network Flacss
(L} My Documents
4 My Computer

Details

Wiew or change settings for this connection, such as adapter, protocol, or modem configur
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Networking Basics
Assigning a Static IP Address — ;
in Windows XP/2000 Sdvanesdy

Connect using:

| B8 D-Link Air DWL520 Wieless PCl Adapter ‘

-4~ Wireless Network Connection 3 Properties @[g|

B Click on Internet Protocol
(TCP/l P) . Thig connection uzes the following items:

% Client For Microsoft Metworks

g File and Printer Sharing for Microsoft Networks

= (0% Packet Scheduler

Interiet Pratacal [TCRAP]

Install... Jrinsta l Froperties '

B Select Use the following IP || - Descrption

B Click Properties.

Tranzmigsion Control Protocaol/Internet Protocol. The default

address in the Internet Proto- wide area networl protocol that provides communication
COl (TCP/l P) Pr Opef t | es W| ndOW actoss diverse interconnected networks. |
(ShOWn bel OW) . Shiow icon in notification area when connected |

[ 0K ][ Cancel ]

B In the window below, select Use the following IP address. Input your IP
address and subnet mask. (The IP Addresses on your network must be
within the same range. For example, if one computer has an IP Address of
192.168.0.2, the other computers should have IP addresses that are
sequential, like 192.168.0.3 and 192.168.0.4. The Subnet mask must be
the same for all the computers on the network.)

IP address:
e.g 192.168.0.2 Internet Protocol (TCP/IP) Properties
| G |
Subnet mask: Aea]
255 255 255 O *Y'ou can get P settings assigned automatically if your network, supparts

thiz capability. Othenwize, you need ta azk your netwerk. administrator for
the appropriate [P settings.

Default gateway:

(7 Obtain an IP address automatically
Enter the LAN IP address Of (@ Uze the following IP address: )

th_e wireless router. (D-Link s o o
wireless routers have a LAN IP i e |
address 0f 192.168.0.1) 57k ol sl

B Select Use the following
DNS server addresses.

(@ Usze the following DMS server addresses: )

Enter the LAN IP address of Prefeed DNS server [192.188. 0 . 1 |
the Wireless Router. (D- Atemate DNS server . . ]
Link wireless routers have a
LAN IP address of
192.168.0.1)
. -_Cance\
B Click OK. E—

You have successfully assigned a Static IP Address.
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Networking Basics (Continued)

Selecting a Dynamic IP Address with Macintosh OSX

m Go to the Apple Menu and
select System  Prefer-
ences.

Double-click on NetworKk.

Select Built-in Ethernet in

- Network =3
the Show pull-down menu. ¢ = & @ O
Location: = Automatic ¥ !
. . ow: juilt-in Ethernet v A |
B Select Using DHCP in the G =)

Configure pull-down menu.

| Manuay

Servers (Optional)

IP Address:
(Provided by DHCP Server)

Subnet Mask: 255.255.255.0

Router: 192.168.0.1 Search Domains (Optional)
DHCP Client ID:

(Optional)

Example: apple.com, earthlink.net
Ethernet Address:

@ Click the lack to prevent further changes. Apply Now

Click Apply Now.

The IP Address, Subnet
mask, and the Router’s |P
Address will appear in a
few seconds.

806C Network =3
W = A 3
E =
,,S,huw All Vﬂsﬂ\ra!sisurund Network %mﬂg@sk
Location: Automatic v !
Show: | Built-in Ethernet "
pppok | AppleTalk | Proxies |
Configure: | Using DHCP ™
Domain Name Servers (Optional)
IP Address: 192.166.0.160
(Provided by DHCP Serves
ISubnet Mask: 255.255.255.0
Router: 192.168.0.1 Search Domains (Optional)
DHCP Client ID

(Optional)

Example: apple.com, earthlink.net

Ethernet Address: 00:06:96:79:de:S5a

@ Click the lock to prevent further changes. [ Apply Now

Iy W
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Networking Basics

Checking the Connection by Pinging in Windows XP and 2000

B Goto Start > Run >
type cmd. A window
similar to this one
will appear. Type
ping
XXX XXX XXX XXX,
where xxx is the IP
Address of the
Router or Access
Point. Agood
wireless connection
will show four replies
from the Wireless
Router or Access
Point, as shown.

AWINDOWS\System32\cmd.exe

Microsoft Windows XP [Uersion 5.1.260881]
{C>» Copyright 1?85-28P1 Hicrosoft Corp.

[F:“Documents and Settings~lab3d*ping 1%72.168.A.58
Pinging 192 _.168_8.50 with 32 hytez of data:

192.168.0.58:
192 .168.8.58:
192.168.8.58: hy 32
192.168.0.58: hytes=32

Ping statistics for 192.168.0.58:

Packets: Sent = 4, Received = 4, Lost = 8 {Bz loss>,
fipproximate round trip times in milli-seconds:

Minimum = Bms, Maximum = Bms. Average = Bms

time{ins TTL=64
time<ims
time<{ims

time{ins

Reply from
Reply from
Reply from

T 4
Reply from TITL=64

F:“Documentz and Settings>lah3>_

Checking the Connection by Pinging in Windows Me and 98

Go to Start > Run
> type command.
A window similar to
this will appear.
Type ping

XXX XXX XXX XXX
where xxx is the IP
Address of the
Router or Access
Point. Agood
wireless connection
will show four
replies from the
wireless router or
access point, as
shown.

o+ FA\WINDOWS\System32\cmd. exe

Microsoft Windows BP [Uersion 5.1.26881
(C> Copyright 1985-2801 Microsoft Corp.

F:“\Documents and Settings“\lab3>ping 192.168.8.58
Pinging 192.168.8.58 with 32 hytes of data:
192.168.0.58: bytez=32 time<{lms
192.168.8.58: hyte time<ims

192.168.0.58: hyte time{ims
192.168.8.58: hytes=32 time<{ims

TTL=64
ITL=64
TTL=64
TTL=64

Reply from

Reply from

Ping statistics for 192.168.8.58:
Packets: Sent = 4. Received = 4, Lost =
Approximate round trip times in milli-seco
Minimum = Bms. Maximum = Bms, Average

(Bx loss),

F:“Documents and Settings“lab3>_
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Resetting the DI-704UP
to the Factory Default Settings

After you have tried other methods for troubleshooting your network, you may
choose to Reset the DI-704UP to the factory default settings.

To hard-reset the D-Link DI-704UP to the Factory Default Settings, please do
the following:
B Locate the Reset button on the back of the DI-704UP.

B Use a paper clip to press the Reset button and power on.

B Hold for about 5 seconds and then release. (Or release
when the status LED flashes.)

B After you have completed the above steps, the DI-704UP
will be reset to the factory default settings.
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Technical Specifications

Standard

IEEE 802.3 10Base-T Ethernet

IEEE 802.3u 100Base-TX Fast Ethernet
IEEE 802.3 NWay Auto-Negotiation
USB 1.1

VPN Pass Through
PPTP
L2TP
IPSec

Ports
One WAN
Four LAN

LEDs

Power

WAN

Printer

Local Network - 10/100

Operating Temperature
32°F to 131°F (0°C to 55°C)

Humidity
95% maximum (non-condensing)
Power

External Power Supply
AC 5V, 2A

Dimensions

L = 7.56 inches (192mm)
W = 4.64 inches (118mm)
H = 1.22 inches (31mm)

Weight
0.68 Ibs (0.31kg)

Warranty
One Year
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Frequently Asked Questions

Why can’t | access the web based configuration?

When entering the IP Address of the DI-704UP (192.168.0.1), you are not connecting
to the Internet or have to be connected to the Internet. The device has the utility built-
in to a ROM chip in the device itself. Your computer must be on the same IP subnet
to connect to the web-based utility.

To resolve difficulties accessing a web utility, please follow the steps below.

Step 1 Verify physical connectivity by checking for solid link lights on the device. If
you do not get a solid link light, try using a different cable or connect to a different
port on the device if possible. If the computer is turned off, the link light will not be
on.

What type of cable should | be using?

The following connections require a Crossover Cable:
Computer to Computer

Computer to Uplink Port

Computer to Access Point

Computer to Print Server

Computer/XBOX/PS2 to DWL-810
Computer/XBOX/PS2 to DWL-900AP+

Uplink Port to Uplink Port (hub/switch)

Normal Port to Normal Port (hub/switch)

The following connections require a Straight-through Cable:
Computer to Residential Gateway/Router

Computer to Normal Port (hub/switch)

Access Point to Normal Port (hub/switch)

Print Server to Normal Port (hub/switch)

Uplink Port to Normal Port (hub/switch)

Rule of Thumb:
"If there is a link light, the cable is right.”
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

What type of cable should | be using? (continued)

What's the difference between a crossover cable and a straight-through
cable?

The wiring in crossover and straight-through cables are different. The two types
of cable have different purposes for different
LAN configurations. EIA/TIA 568A/568B
define the wiring standards and allow for
two different wiring color codes as

1 White-Green
2 Green

3 White-Orange
4 Blue
5
6
7

illustrated in the following diagram. ggggflue

. . White-Brown
*The wires with colored backgrounds may 8 Brown
have white stripes and may be denoted 5684 CABLE END

that way in diagrams found elsewhere. White-Orange

1
How to tell straight-through cable from 2 Orange
acrossover cable: _ g E}ﬁﬁe_mue
The main way to tell the difference 6

between the two cable types is to compare !
the wiring order on the ends of the cable. If
the wiring is the same on both sides, it is

straight-through cable. If one side has opposite wiring, it is a crossover cable.

Green
White -Brown
8 Brown

5688 CABLE END

All you need to remember to properly configure the cables is the pinout order of
the two cable ends and the following rules:

A straight-through cable has identical ends

A crossover cable has different ends

It makes no functional difference which standard you follow for straight-through
cable ends, as long as both ends are the same. You can start a crossover cable
with either standard as long as the other end is the other standard. It makes no
functional difference which end is which. The order in which you pin the cable is
important. Using a pattern other than what is specified in the above diagram
could cause connection problems.

When to use a crossover cable and when to use a straight-through cable:
Computer to Computer — Crossover

Computer to an normal port on a Hub/Switch — Straight-through

Computer to an uplink port on a Hub/Switch - Crossover

Hub/Switch uplink port to another Hub/Switch uplink port — Crossover

Hub/Switch uplink port to another Hub/Switch normal port - Straight-through
78




Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 2 Disable any Internet security software running on the computer. Software
firewalls like Zone Alarm, Black Ice, Sygate, Norton Personal Firewall, etc. might
block access to the configuration pages. Check the help files included with your
firewall software for more information on disabling or configuring it.

Step 3 Configure your Internet settings.

Go to Start>Settings>Control Panel. Double click
the Internet Options Icon. From the Security tab,
click the Default Level button to restore the
settings to their defaults.

Click to the Connection tab and set the dial-
up option to Never Dial a Connection. Click

the LAN Settings button

Nothing should be checked. Click OK

Go to the Advanced tab and click the
Restore Defaults button to restore
these settings to their defaults.

Click OK. Go to the desktop and close any open
windows

= e )

2 Web content one to specly s seculy selings.

Interet

t
O This zone cortains S Web sies you

Secuay vl o tis zone
Move the sidet toset the sy levelor this zone,

-k High

The safst way o iowse, bt s the et fncinsl
| - L seaueleatues e diabied

~Apstcpiae for ses it might v hami cortnt

Custon Level Defauk Lovel

| Pivcy| Content Comsctons | rogans | e

1 et o et eoecion cck

L
LAN Seltings do not apply o disup connectons. AN Selings.
Choose Setings above fo diakup selings. =

ride manual setings. To ensure the
ulomaic configuralion.

[~ Use aprogy server for your LAN [These seltings wil not apply to
diskup or VPN ).




Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 Check your IP Address. Your computer must have an IP Address in the same
range of the device you are attempting to configure. Most D-Link devices use the
192.168.0.X range.

How can | find my IP Address in Windows 95, 98, or
ME?

Step 1 Click on Start, then click on Run.

Step 2 The Run Dialogue Box will appear. Type winipcfg in the text field and
then click OK.
Run 2 1]

Type the name of & program, folder, or document, ahd
windows will open it for you.

DOpen: |winipcfg j

Ok i Cancel | Browse... |

Step 3 The IP Configuration window will appear, displaying your Ethernet
Adapter Information.

M Select your adapter from the drop down menu.

M If you do not see your adapter in the drop down menu, your adapter is
not properly installed.

IP Configuration M= 3

— Ethemet Adapter Information

Adapler sddiess [0 Tink DFE 55012 10/100 Adapter

IP Address 0000
Subnet Mask. oooo
Default Gateway ’7

ak I Eelease | Ferne |

Fielegse Al | Fienew Al | More Info > |

Step 4 After selecting your adapter, it will display your IP Address, subnet
mask, and default gateway.
Step 5 Click OK to close the IP Configuration window.
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 (continued) Check your IP Address. Your computer must have an IP Address
in the same range of the device you are attempting to configure. Most D-Link devices
use the 192.168.0.X range.

How can | find my IP Address in Windows 2000/XP?

Step 1 Click on Start and select Run.

Step 2 Type cmd then click OK.
Run B3

~ Type the name of a program, Folder, document, ar
Internet resource, and YWindows will open it For you,

12

en: | cmd |2

[ ol H Cancel H Browse, ., J

Step 3 From the Command Prompt, enter ipconfig. It will return your IP
Address, subnet mask, and default gateway
INNT' sy¥stem32',CMD.EXE :

Mic t Windows 2888 [Version 5.88.21951]
<G> Copyright 1985-2888 Microsoft Corp.

D:s2>dipconfig

Windows 2888 IP Configuration

Ethernet adapter Local Area Connection:
gpecific DNS Suffix

LT T Tt 192 168.0.174
LIl I ...l :o55agg.agt.g

c e e e e e e . o. i 192.168.8.1

Step 4 Type exit to close the command prompt.
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 (continued) Check your IP Address. Your computer must have an IP Address
in the same range of the device you are attempting to configure. Most D-Link devices
use the 192.168.0.X range.

Make sure you take note of your computer’s Default Gateway IP Address. The Default
Gateway is the IP Address of the D-Link router. By default, it should be 192.168.0.1.

How can | assign a Static IP Address in Windows XP?

Step 1
Click on Start > Control Panel > Network and Internet Connections >
Network connections.

Step 2 See Step 2 for Windows 2000 and continue from there.

How can | assign a Static IP Address in Windows 20007

Step 1 Right-click on My Network
Places and select Properties.

Step 2 Right-click on the Local Networl and Dialup 555, s
Area Connection which represents [

your network card and select i

Properties.

2=

Cannect using:

I D-Link DFE-530TX PCI Fast Ethermet Adapter

Campanents checked are used by this cannectior:

nghllght |nternet Protocol (TCP/ [ {2 File and Printer Sharing for Microsolt Networks
IP) and click Properties. .

Install Urinsial | Poparties |

- Deseription
Transmission Control Protocol/Intemet Protocol. The default
wide area nebwork protocol that provides communication
across diverse interconnected networks,

[# Show icon in taskbar when connected

0K Cancel
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

How can | assign a Static IP Address in Windows 20007?

(continued)

Click Use the following IP Address and
enter an IP Address that is on the same
subnet as the LAN IP Address on your
router. Example: If the router’s LAN IP
Address is 192.168.0.1, make your IP

Internet Protocol {TCP/IP) Properties 2l x|

General

“You can get IP settings assigned automatically if your network supports
thiz capability. Othenwise, you need to ask pour netwark administrator for
the appiopriate IP ssttings

" Dbtain an IF addiess automatically

(& Ugs the following [P address

Address 192.168.0.X where X = 2-99. P sdess ERERIEY
Make sure that the number you choose is St [ 2% 2% 0
not in use on the network. Defaul galewa [T 68 0 1

€ [ptain DHS server address automatically
Set the Default Gateway to be the @ U mmiiB el ————————
same as the LAN IP Address of your e W
router (192.168.0.1).

Advanced...

Set the Preferred DNS server to be the el _|

same as the LAN IP address of your
router (192.168.0.1).

The Alternate DNS server is not needed or enter a DNS server from your ISP.

Click OK twice. You may be asked if you want to reboot your computer. Click
Yes.

How can | assign a Static IP
Address in Windows 98/Me?

Network

Corfiguration | dentiication | Access Control |

The following network components are installed:

Client for Microsoft Metwarks
D-Link DFE-530T PCI Fast Ethemet Adapler (Rew &)

Step 1 From the desktop, right-click on the
Network Neigborhood icon (Win ME - My

Network Places) and select Properties

Propetties |

4dd | Remove |

Frimary Metwork Logan

Highlight TCP/IP and click the Properties [Gient o Moot etwotks h
button. If you have more than 1 adapter, [(Eotmans |
then there will be a TCP/IP “Binding” for o ————
each adapter. Highlight TCP/IP > (your
network adapter) and then click

Cancel

Properties.
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

How can | assign a Static IP Address in Windows

98/Me? (continued)
Step 2 Click Specify an IP Address.

Enter in an IP Address that is on the same
subnet as the LAN IP Address on your router.
Example: If the router’s LAN IP Address is
192.168.0.1, make your IP Address
192.168.0.X where X is between 2-99. Make
sure that the number you choose is not in
use on the network.

Step 3 Click on the Gateway tab.

Enter the LAN IP Address of your router
here (192.168.0.1).

Click Add when finished.

Step 4 Click on the DNS Configuration tab.

Click Enable DNS. Type in a Host (can be
any word). Under DNS server search order,
enter the LAN IP Address of your router
(192.168.0.1). Click Add.

Step 5 Click OK twice.

When prompted to reboot your computer,
click Yes.

After you reboot, the computer will now have
a static, private IP Address.

Step 5 Access the web management. Open your web
browser and enter the IP Address of your D-Link device in
the address bar. This should open the login page for the web

| adwenced | nemos |
| Gateway | WING Corfiguation P Addiess

1P Address: 192.166. 0 .10
Subnet Mask: | 255.255.255. 0

Cancel
I
Advancer | NetiDs |

n Gater y|ww5: riiguation | IP Address

Thrtgt ayin Ah\ A\Idatwyuwmbth dr ult
d in the list wil be the order
eeeeeeeeeeeee

New gateway:

192.168. 0 . 1 Add

276801 Femove

| Advanced | nNemios |
| Getewsys | WINS Configuation | 1P Address

Binding
DNS Conligu

" Disable DNS
& Encble DNS

Host | anpthing Domain |

DNS Server Search Order

132.168.0.1 R eeeee

Domain Suffix Search Order

management. Follow instructions to login and complete the configuration.
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Frequently Asked Questions (continued)

How can | setup my router to work with a Cable modem connection?

Dynamic Cable connection
(i.e. Cox, Adelphia, Rogers, Roadrunner, Charter, and Comcast).

Note: Please configure the router with the computer that was last connected directly
to the cable modem.

Step 1 Log into the web based Connect to 192.168.0.1

configuration by typing in the IP =

Address of the router F (1

(default:192.168.0.1) in your web bR

browser. The username is admin

(all lowercase) and the password DL-704LIF

is blank (empty).
Iser name: |ﬂ admin v|
Password; | |

[Jremember my passward

[ Ok ][ Cancel J

Step 2 Click the Home tab
and click the WAN button.

D-Link

BUIGG NETWOrKS for Peopie

DI-704UP
Ethernet Broadband Router

Home [CIENCECAEE T Status Help

By default, Dynamic IP
Addl‘eSS |S the Selected OptIOFI Q Please select the appropriate option to connect o your ISP,

@ Dynamic IP Address Choose this aption to obtain an |P address autormatically
ftorm your ISP (For mast Cable moderm users)
Cllck CI O n e Mac Ad d ress . © Static IP Address VCDTE\;S\?DLS\;;]UDMD set static IP information provided to
©) PRPGE Ghoose this aption ifyour ISP uses PPPOE. (Far most DSL
T users)
H Others PPTP and BigPond Cable
Click on Apply and then ©
Continue to save the changes. HastName Vo
HAG pdress o Jfo 1o Jfo 1 Jo |
Primary DNS Address loooo |
Secondary DNS Addrass
MTL 1500
Aute-reconnect ©Enabled O Disabled

@ 00O

Apply Cancel Help
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Frequently Asked Questions (continued)

How can | setup my router to work with a Cable modem connection?
(continued)

Step 3 Power cycle the cable modem and router:

First turn the cable modem off. Next, turn the router off Leave them off for 2 minutes**.
After 2 minutes**, turn the cable modem on. Wait until you get a solid cable light on
the cable modem, and then turn the router on. Wait 30 seconds.

** |f you have a Motorola (Surf Board) modem, leave off for at least 5 minutes.

Step 4 Follow step 1 again and log back into the web configuration. Click the Status
tab and click the Device Info button. If you do not already have a public IP Address

under the WAN heading, click on the DHCP Renew and Continue buttons.

Static Cable Connection
Step 1 Log into the web based configuration by typing in the IP Address of the router
(default:192.168.0.1) in your web browser. The username is admin (all lowercase) and

the password is blank (empty). Connect to 192.168.0.1 e

=

WA
Step 2 Click the Home tab and click the WAN Y
button. Select Static IP Address and enter your b @an
static settings obtained from the ISP in the fields Tl . ]
provided. [ emenber my pasord
If you do not know your settings, you must
contact your ISP.

DI-704UP

Step 3 Click on App|y and then Ethernet Broadband Router

- : ..
click Continue to save the sl S S S S

Chan es ? Please selectthe appropriate option to connectto your ISP
g © Dynamic IP Address acse this option to obtain an IP address automatical
from
a0se this o i
you by
i

Step 4 Click the Status tab and 2

click the Device Info button. Pk o overs

Your IP Address information will =S e P Addres ‘ ,

be displayed under the WAN - -

heading. — —
S:;":nr:aNDNSAddvess wj

MU [rs00 ]

@ © O

Apply Cancel Help
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Frequently Asked Questions (continued)

How can | setup my router to work with Earthlink DSL or any PPPoE
connection?

Make sure you disable or uninstall any PPPoE software such as WinPoet or Enternet
300 from your computer or you will not be able to connect to the Internet.

Step 1 Upgrade Firmware if needed.

(Please visit the D-Link tech support website at: http://support.dlink.com for the latest
firmware upgrade information.)

Step 2 Take a paperclip and perform a hard reset. With the unit on, use a paperclip
and hold down the reset button on the back of the unit for 10 seconds. Release it and
the router will recycle, the lights will blink, and then stabilize.

Step 3 After the router stabilizes, open your browser and enter 192.168.0.1 into the
address window and hit the Enter key. When the password dialog box appears, enter
the username admin and leave the password blank. Click OK.

If the password dialog box does not come up repeat Step 2.
Note: Do not run Wizard.
Step 4 Click on the WAN tab on left-hand side of the screen. Select PPPoOE.

Step 5 Select Dynamic PPPoE (unless your ISP supplied you with a static IP
Address).

Step 6 Inthe username field enter ELN/username@earthlink.net and your
password, where username is your own username.

For SBC Global users, enter username@sbcglobal.net.
For Ameritech users, enter username@ameritech.net.
For BellSouth users, enter username@bellsouth.net.

For Mindspring users, enter username@mindspring.com.
For most other ISPs, enter username.

Step 7 Maximum Idle Time should be set to zero. Set MTU to 1492, unless
specified by your ISP, and set Autoreconnect to Enabled.

Note: If you experience problems accessing certain websites and/or email issues,

please set the MTU to a lower number such as 1472, 1452, etc. Contact your ISP for
more information and the proper MTU setting for your connection.

87




Frequently Asked Questions (continued)

How can | setup my router to work with Earthlink DSL or any PPPoE
connection? (continued)

Step 8 Click Apply. When prompted, click Continue. Once the screen refreshes,
unplug the power to the D-Link router.

Step 9 Turn off your DSL modem for 2-3 minutes. Turn back on. Once the modem
has established a link to your ISP, plug the power back into the D-Link router. Wait
about 30 seconds and log back into the router.

Step 10 Click on the Status tab in the web configuration where you can view the
device info. Under WAN, click Connect. Click Continue when prompted. You should
now see that the device info will show an IP Address, verifying that the device has
connected to a server and has been assigned an IP Address.

Can | use my D-Link Broadband Router to share my Internet
connection provided by AOL DSL Plus?

In most cases yes. AOL DSL Plus may use PPPoE for authentication bypassing the
client software. If this is the case, then our routers will work with this service. Please
contact AOL if you are not sure.

To set up your router:

Step 1Log into the web based configuration by typing in the IP Address of the router
(default:192.168.0.1) in your web browser. The username is admin (all lowercase) and
the password is blank (empty).

Step 2 Enter your screen name followed by @aol.com for the user name. Enter your
AOL password in the password box.

Step 3 You will have to set the MTU to 1400. AOL DSL Plus does not allow for
anything higher than 1400.

Step 4 Click Apply.

Step 5 Recycle the power to the modem for 1 minute and then recycle power to the
router. Allow 1 to 2 minutes to connect.

If you connect to the Internet with a different ISP and want to use the AOL software,
you can do that without configuring the router’s firewall settings. You need to
configure the AOL software to connect using TCP/IP.

Go to http://www.aol.com for more specific configuration information of their software.
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Frequently Asked Questions (continued)

How do | open ports on my router?

To allow traffic from the Internet to enter ‘Link
your local network, you will need to open Bi==r= DI-704UP
up ports or the router will block the o [T S e .
lvance: ools atus elp
request. i
. OEnabled O Disabled
Step 1 Log into the web based : —_— ]
configuration by typing in the IP Address by o
of the router (default:192.168.0.1) in your gprist | ]
web browser. The username is admin (all s Omm
lowercase) and the password is blank e
(empty). =l % o0
Apply Cancel Help
Step 2 Click on Advanced on top and T —
then click Virtual Server on the left = pemr B2 Emmoee  0F
. “irtual Server DNS 0000 UDF§3/63  atways 4]
Step 3 Check Enabled to activate ﬁﬂ
entry. v:n::wa::::mnm 0000 TCP 23123 :\m J‘['\l
1PSec. 0000 TCP 5004500 always B
e sase TR e 1]
Step 4 Enter a name for your virtual bast  pmm gvs BN
server entry. D i
DCS2000 0000 ?Sé"aﬂ?m atways El]
Step 5 Next to Private IP, enter the IP

Address of the computer on your local
network that you want to allow the
incoming service to.

Step 6 Choose Protocol Type - either TCP, UDP, or both. If you are not sure, select
both.

Step 7 Enter the port information next to Private Port and Public Port. The private
and public ports are usually the same. The public port is the port seen from the WAN
side, and the private port is the port being used by the application on the computer
within your local network.

Step 8 Set the Schedule information.
Step 9 Click Apply and then click Continue.

Note: Make sure DMZ host is disabled. If DMZ is enabled, it will disable all Virtual
Server entries.

Because our routers use NAT (Network Address Translation), you can only open a specific
port to one computer at a time. For example: If you have 2 web servers on your network,
you cannot open port 80 to both computers. You will need to configure one of the web
servers to use port 81. Now you can open port 80 to the first computer. 89



Frequently Asked Questions (continued)

What is DMZ?

Demilitarized Zone:

In computer networks, a DMZ (Demilitarized Zone) is a computer host or small
network inserted as a neutral zone between a company’s private network and the
outside public network. It prevents outside users from getting direct access to a
server that has company data. (The term comes from the geographic buffer zone that
was set up between North Korea and South Korea following the UN police action in
the early 1950s.) ADMZ is an optional and more secure approach to a firewall and
effectively acts as a proxy server as well.

In a typical DMZ configuration for a small company, a separate computer (or host in
network terms) receives requests from users within the private network for access to
Web sites or other companies accessible on the public network. The DMZ host then
initiates sessions for these requests on the public network. However, the DMZ host is
not able to initiate a session back into the private network. It can only forward packets
that have already been requested.

Users of the public network outside the company can access only the DMZ host. The
DMZ may typically also have the company’s Web pages so these could be served to
the outside world. However, the DMZ provides access to no other company data. In
the event that an outside user penetrated the DMZ hosts security, the Web pages
might be corrupted but no other company information would be exposed. D-Link, a
leading maker of routers, is one company that sells products designed for setting up

aDMZ

How do | configure the DMZ Host?

The DMZ feature allows you to forward all incoming ports to one computer on the local
network. The DMZ, or Demilitarized Zone, will allow the specified computer to be
exposed to the Internet. DMZ is useful when a certain application or game does not
work through the firewall. The computer that is configured for DMZ will be completely
vulnerable on the Internet, so it is suggested that you try opening ports from the
Virtual Server or Firewall settings before using DMZ.

Step 1 Find the IP address of the computer you want to use as the DMZ host.
To find out how to locate the IP Address of the computer in Windows XP/2000/ME/9x

or Macintosh operating systems please refer to Step 4 of the first question in this
section (Frequently Asked Questions).
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Frequently Asked Questions (continued)

How do | configure the DMZ Host? (continued)

Step 2 Log into the web based configuration [FSSSSrSpPpRRe
of the router by typing in the IP Address of the

router (default:192.168.0.1) in your web @\\
browser. The username is admin (all W
lowercase) and the password is blank
(empty). DI-704UP
User narne: |!E admin v|

Password: | |

[Iremember my password

I Ok, H Cancel ]

Step 3 Click the Advanced tab and then click on the DMZ button. Select Enable
and type in the IP Address from Step 1.

D-Link

Bung Networss for Feopie DI-704UP

Ethernet Broadband Router

Step 4 Click Apply | Home WUIPTTITE Tools Status Help
and then CO ntl nue to o B;\E(Dem\htarlzed Zone) is used to allow a single cormputer on the LAN to be exposed to
save the changes. = e ater

(I Enabled (@ Disabled
Note: When DMZ is G 2
enabled, V_|rtua_1l Server 9 OO0
settings will still be Apply Cancel Help
effective. Remember, Fitter

you cannot forward the
same port to multiple

Fire:

il

IP Addresses, so the snwp |
Virtual Server settings
will take priority over

[

DMZ settings. Routing

DMz
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Frequently Asked Questions (continued)

How do | open a range of ports on my DI-704UP using Firewall rules?

Step 1 Log into the web based configuration by typing in the IP Address of the router
(default:192.168.0.1) in your web browser. The username is admin (all lowercase) and
the password is blank (empty).

If you are having difficulty accessing web management, please see the first question
in this section.

Step 2 From the web management Home page, click the Advanced tab then click
the Firewall button. D-Link

Step 3 Click on S DI-704UP

Enabled and type ina Ethernet Broadband Router
Advanced Bl Status Help
name for the new rule. —_—

Firewall Rules can be used to allow or deny traffic from passing through the DI-TO4UP

O Enabled O Disabled

Step 4 Choose WAN fame | 1

as the Source and Virtual Server Acton O Ao O Deny
Interface 1P Start IP End Protocol  PortRange

enter a range of IP aniiceton i :

Addresses out on the

Destination |* _-v_‘ [ I j\ e "_I |_"_!

LEE 4

internet that you would net sehedule © awars o
like this rule applied cia O e 0 B o o oo
to. If you would like [
this rule to allow all g,, c;ﬂe, E?,p
internet users to be - .
able to aCCeSS these AEImnNéme B Source Destination Protocal

Routing Allows Allow to Ping WiAN port WAN® LAN,192.168.0.1 ICHP,* [
ports’.then*p.Ut an . - Deny Default i M 3
Asterisk ( ) in the first s Allow Default LAN *19216801 7 4]

box and leave the
second box empty.

Step 5 Select LAN as the Destination and enter the IP Address of the computer on
your local network that you want to allow the incoming service to. This will not work

with a range of IP Addresses.

Step 6 Enter the port or range of ports that are required to be open for the incoming
service.

Step 7 Click Apply and then click Continue.
Note: Make sure DMZ host is disabled.

Because our routers use NAT (Network Address Translation), you can only open a
specific port to one computer at a time. For example: If you have 2 web servers on
your network, you cannot open port 80 to both computers. You will need to configure
1 of the web servers to use port 81. Now you can open port 80 to the first computer
and then open port 81 to the other computer. 92



Frequently Asked Questions (continued)

What are virtual servers?

A Virtual Server is defined as a service port, and all requests to this port will be
redirected to the computer specified by the server IP. For example, if you have an FTP
server (port 21) at 192.168.0.5, a Web server (port 80) at 192.168.0.6, and a VPN
server (port 1723) at 192.168.0.7, then you need to specify the following virtual server
mapping table:

21 192.168.0.5 X
80 192.168.0.6 X
1723 192.168.0.7 X

How do | use PC Anywhere with my DI-704UP router?

You will need to open 3 ports in the Virtual Server section of your D-Link router.

Step 1 Log into the web based configuration by typing in the IP Address of the router
(default:192.168.0.1) in your web browser. The username is admin (all lowercase) and
the password is blank (empty).

Step 2 Click on Advanced at the DI-704UP
. . Ethernet Broadband Router
top and then click Virtual Server Peome T e | Tielp
on the left side. Q o v 55610 alow ot srsacass o LN snicos
' @®enabled O Disabled
Step 3 Enter the information as e
seen below. The Private IP is the =
IP Address of the computer on T e mEBEE-EEEE
your local network that you want et 9 9 e
to connect to. s s e
_ _ T
Step 4 The first entry will read — Mt G e o
as shown here: il o ﬁ
i ) ]
0000 TCP 5001500 always JHI
Step 5 Click Apply and then oo e e B8
click Continue. - W
DCs2000 0000 55535’?”1”‘ always. £)]
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Frequently Asked Questions (continued)

How do | use PC Anywhere with my DI-704UP router? (continued)

D-Link

g fetworks fo People

DI-704UP
Ethernet Broadband Router

m Advanced [T 0 Status Help

Virtual Server
Q Virual Server s Used o alow Inferet users access to LAN senices
®Enabled O Disabled

Step 6 Create a second entry as shown.

Name peanywherez
Private IP 192.168.0.

ProocoiTs [t 9]

O —

Pusicpot [ ]

Schedule ® Aways

Ofom  Tme[@ ¥

fro[o0 %30 9]

2 9 0

Apply Cancel Help

PR

Step 7 Click Apply and then click o N e e
p pp y - Virtual Server HTTP 0000 TCPB0I80  always E))
. E))

Continue.

Virtual Server DNS 0000 UDP 53153 atways E)]
Virtual Server SMTP 0000 TCP25125  always £l ]
Virual SemerPOPS 0,000 TCP 1104110 always el
Virual Server Telnet  0.0.00 TCP23123  atways B
IPsec 0000 TCP 5004500 atways eV
PPTP 0000 1o TR awars E) ]
DCs1000 0000 BOB0/80  aways E)]
DC81000 0000 Bol 8481/ aiways @
)
Des2000 0000 BONB0/80  aways EL ]
Both 5001- o
Des2000 0000 5003/5001-  aways eV

Step 8 Create a third and final entry as shown here:

D-Link

Baiing Networks fo Feope

DI-704UP
Ethernet Broadband Router

m Advanced SR {13 Status Help

Virtual Server
Q Virtual Server 5 used to allow Inferet users access to LAN services.
@Enabled O Disabled

Name. peanywhered

Private IP 1921680,

Protocol Type e v

Private Port ]
Public Port
Schedule ® Aways

O From  Time 00 w00 wiro 00 ][00 v

i[5 Woon B
Apply Cancel Help
=l

Virtual Server List

Name Privale [P Profocol  Schedule
Step 9 Click App|y and then click VaISaverHTT 0000 TOPADISD sy 2
Virual Sener TIPS 0.000 TOP 4431443 always )]
C t Virtual Server DNS 0000 UDP 53153 atways E))
ontinue. s 0000 TePzsizE owrs ey
Virtual Server POP3 0000 TCR 1104110 aways E))
Virtual Server Telnet 0000 TCP23123  always £} )
IPsec 0000 TCP 5001500 always E} ]
PPTP 0000 TPV aiways £} ]
1723
Des1000 0000 BOB0/80  aways £} )
Deston 0000 Bl 481 atways E) ]
Des2000 0000 Bon80/80  aiways E} ]
Both 5001-
0Cs2000 0000 500315001 atways £} )

Step 10 Run PCAnywhere from the remote site and use the WAN IP Address of the
router, not your computer’s IP Address.
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Frequently Asked Questions (continued)

How can | use eDonkey behind my D-Link Router?

You must open ports on your router to allow incoming traffic while using eDonkey.

eDonkey uses three ports (4 if using CLI):

4661 (TCP) To connect with a server

4662 (TCP) To connect with other clients

4665 (UDP) To communicate with servers other than the one you are connected to.
4663 (TCP) *Used with the command line (CLI) client when it is configured to allow
remote connections. This is the case when using a Graphical Interface (such as the

Java Interface) with the client.

Step 1 Log into the web based configuration by typing in the IP Address of the
router (default:192.168.0.1) in your web browser. The username is admin (all
lowercase) and the password is blank (empty).

D-Link
Buligmg Networks for Peopie DI-70 4U P
) Ethernet Broadband Router
Step 2 Click on BLEET Advanced JRETIE Status Help
Advanced and then CIICk g F‘\rewaHRu\;scanbeusedtoalluwordenvnam:fmmnassingthraughtheDI-704UF‘
Firewall. .
@Enabled O Disahled
Name [edonkey 1

Step 3 Cl’eate anew Action ®alow O Deny
] . Interface 1P Start IP End Protocol  Fort Range
f|r_ewall rule: - e e
CI'Ck Enabled- Destination | LAN | | 1921680100 | | | [ree %] [aee1 ]| 665
Enter a name (edonkey). seeie  @awes -
Click Allow. Next to Ficowal W

Source, select WAN under
interface. In the first box,
enter an *. Leave the DoNS

Apply Cancel Help

Action Narme Source Destination Pratocal
Routing ¥ Allow Allowto Ping WAN port  VWAN,® LAN,182.168.0.1 ICMP~ B}

second box empty. Next to
Destination, select LAN < Dy Dstaun L Bu
under interface_ Enter the e ¥ Allow Default LAN* *-19216801 =" B}
IP Address of the computer
you are running eDonkey

from. Leave the second

Ll

box empty. Under Protocol, select *. In the port range boxes, enter 4661 in the first
box and then 4665 in the second box. Click Always or set a schedule.

Step 4 Click Apply and then Continue.
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Frequently Asked Questions (continued)

How do | set up my router for SOCOM on my Playstation 27?

To play SOCOM and hear audio, you must download the latest firmware for the router
(if needed), enable Game Mode, and open port 6869 to the IP Address of your
Playstation.

Step 1 Upgrade the firmware.

Step 2 Log into the web based configuration by typing in the IP Address of the
router (default;:192.168.0.1) in your web browser. The username is admin (all
lowercase) and the password is blank (empty).

Step 3 Click on the Advanced tab and then click on Virtual Server on the left side.

Step 4 You will now create a new Virtual Server entry. Click Enabled and enter a
name (socom). Enter the IP Address of your Playstation for Private IP.

Step 5 For Protocol Type select Both. Enter 6869 for both the Private Port and
Public Port. Click Always. Click Apply to save changes and then Continue

DI-704UP
Ethernet Broadband Router

| Home WUIELLLE Tools Status Help

9 Vit St 1 s 1ol et s e o LA sences
®Enabled O Disabled

Name socom ]
T R
e [Bothv]
PrvatePor 6869 |
Public Port 6869
il o
Schedule @ aways
- O From  Time 30 o0 Wi 00 90 @

T e

Apply Cancel Help
DDNS

Narne PrivatelP  Profocol  Schedule

Virual Server FTP 0000 TCP21/21  aways E)]
0000 TCPBOIB0  always el
0000 TCP 4431443 always E)i]
0000 UDP 53153 always E)]
0000 TCP25125  always @
0000 TCP 1101110 always Eji]
0000 TCP23/23  always E)]
0000 TCP 5001500 always [E)]

oo 0000 TRIBI e 23

oMz

poston 0000 Bot80re0  always el

ocsiono ooo0  BESTI g ]

DCS2000 0000 Both80/80  always [£]7)

Bothn 5001- :

Des2000 0000 500375001 always E)i]
3

Step 6 Click on the Tools tab and then Misc on the left side.

Step 7 Make sure Gaming Mode is Enabled. If not, click Enabled. Click Apply
and then Continue.
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Frequently Asked Questions (continued)

How can | use Gamespy behind my D-Link router?

Step 1 Log into the web based configuration by typing in the IP Address of the
router (default:192.168.0.1) in your web browser. The username is admin (all
lowercase) and the password is blank (empty).

Step 2 Click on the Advanced tab and then click Virtual Server on the left side.

Step 3 You will create 2 entries.

Step 4 Click Enabled and enter settings:

NAME - Gamespyl

PRIVATE IP - The IP
Address of your computer
that you are running
Gamespy from.

PROTOCOL TYPE - Both

PRIVATE PORT - 3783
PUBLIC PORT - 3783
SCHEDULE - Always.

Click Apply and then Continue

Step 5 Click Enabled and enter settings:

NAME - Gamespy2

PRIVATE IP - The IP Address of
your computer that you are
running Gamespy from.

PROTOCOL TYPE - Both
PRIVATE PORT - 6500
PUBLIC PORT - 6500
SCHEDULE - Always.

Click Apply and then Continue.

\

Virtual Server

Application

Filter

Firewall

SNMP

DDNS

Routing

i il

\

Virtual Server

Application

Filter

Firewall

SNMP

Routing

Ll il

oMz

DI-704UP
Ethernet Broadband Router

| Home WYWTIFYR Tools | Status Help

Virtual Server s used to allow Intemet users access to LAN senvices,

@Enavled O Disabled
Narme bamespyr |
Poe 1021690 10
Protocol Type. Both ¥

Private Port -
Public Port s
Schedule © aways

O from  Time[00 ][00 Wit o0 ¥{00 ]

9 9 0

Apply Cancel Help

day[sn Vlo[sin v]

Name Private P Protocal Schedule

WSt TP 0000 ToPati2n o e}
ST 0000 ToRG0rs0  awars Y
Vialsener TIPS 0000 ToP 4631443 awars 20
WalsewroNs 0000 UORSy/S  awars @
Virtual Server SMTP 0000 TCP25/25  always E)]
UialsenerPOPS 0000 ToPHOI11O abrs Y]
VaiseverTanet 0000 ToPZ3I20  awars e}
e 0000 ToPs/sm0 aivars E}
eere o000 TR e o9
ocstomn 0000 Bomsosn awvars B
ocstono oonp BN @
ocsa0 0000 consorso ahars T
oripecy
ocsa0 0000 sodsint ahars ]

DI-704UP
Ethernet Broadband Router

[ Home WYWYITYE Tools | Status Help

Virtual Server s used 1o allow Inferet users access to LAN services.

@Enabled O Disabled

Name lgamespye ]
Private P 192168.0/100 ]
ProtocoiTyse 5o ¥

PvatePot  [es00

Public Port | 6500

Schedule ® Aways

O From  Time[80 V00 Wiro[on oo ]
day[Sun to[sen &

Apply Cancel Help

irtual Server L
Narne. Piivate [P Protocol Schedule

WssenerTe 0000 ToRatia  awas el
WnsenerHTE 0000 ToPcory  aiwrs L]
VS HTIRS 0000 ToR 4431443 anwrs Ll
UnasenONs 0000 UOPSIs3  awas Y
s 0000 Torzsizs  awas L]
WiasenerPoPs 0000 ToR 1101110 ahwars L]
UtsasenerTeiet 0000 ToR2sizs  aws Ef
P 0000 Topsoossn awars L
e 0000 TR s @9
oostann 0000 comsoiso e 29
oosionn o000 BRSEI 81
ooz 0000 coneureo  awas e

son oot :
ooz o000 Eom /s s au




Frequently Asked Questions (continued)

How do | configure my router for KaZaA and Grokster?

The following is for KaZaA, Grokster, and others using the FastTrack P2P file sharing
system.

In most cases, you do not have to configure anything on the router or on the Kazaa
software. If you are having problems, please follow steps below:

Step 1 Log into the web based configuration by typing in the IP Address of the router
(default:192.168.0.1) in your web browser. The username is admin (all lowercase) and
the password is blank (empty).

Step 2 Click on Advanced and then click Virtual Server.
Step 3 Click Enabled and then enter a Name (kazaa for example).

Step 4 Enter the IP Address of the computer you are running KaZaA from in the
Private IP box. Select TCP for the Protocol Type.

Step 5 Enter 1214 in the Private and Public Port boxes. Click Always under
schedule or set a time range. Click Apply.

D-Link
e DI-704UP
Ethernet Broadband Router

BT Advanced T Status Help
? Virtual Server is used to allow Internet users access to LAN senices
#®Enabled O Disabled
Name kazaa
Virtwal Server Private IP 192168.0100 |
—_— Protocol Type [ TP
ersror 500 ]
Public Part 6500
Filter !
Schedule ® Aways
EE B8
day[Sn Vto[sin ]
et v
SNmP )
Apply Cancel Help
DDNS
[ Name Private P Protocel Sehedule
NErRy Virual Server FTP 0000 TCP2UN  always [E{]
Virual Gerver HTTP 000.0 TCPBOISD  ahways E))
oMz E)
Virual Server HTTPS  0.0.0.0 TCP 4431443 always E)7)
Virual Server DNS 0000 UDP 53153 atways 2}
Virual Server SMTP 000.0 TCP25/25  always [Ej]
Virual Gerver POP3 000.0 TP 101110 ahways E))
Virual Gerver Telnet 0000 TCP23123  always £}
1PSec 0000 TCPS00/500 always [Ej7)
Top 17234 E
eere ooop TRITBI e @
Des1000 0000 Both0/80  ahways [E{7)
Des1000 000.0 Both 84011 aways El ]
082000 0000 BoinS0/80  ahways el
Botn 5001- -
DCs2000 0000 500345001~ ahways £l

Note: Make sure that you did not enable proxy/firewall in the KaZaA software.
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Frequently Asked Questions (continued)

How do | configure my router to play Warcraft 3?

To host a Warcraft 3 game, you must open ports on your router to allow incoming
traffic. To play a game, you do not have to configure your router.

Warcraft 3 (Battlenet) uses port 6112. D-Link DLLTOAUP
Ethernet Broadband Router
For the DI-704UP: SLTT Advanced BTN RN
Step 1 LOg IntO the Web based E @ Enapled O Disabled
configuration by typing in the IP p_— ThE |
Address of the router _ e (ol
(default:192.168.0.1) in your web .
. . Filter
browser. The username is admin it —
(all lowercase) and the password is won Sl
blank (empty). 9 90
= l Apply Cancel Help
Step 2 Click on Advanced and e L e Tl Ui
then click Virtual Server. _—— e & e e
Virtual Server DNS 0000 UDP3/53  always [E]7]
Virtual Server SMTP 000 TCP 25525  always [E)]
Step 3 Create a new entry: Click e n o om
Enabled. Enter a name (warcraft3). - T e j{:
Private IP - Enter the IP Address of Desto0n 0000 ;Zsamn atways _am
the computer you want to host the . SO =5
game. Select Both for Protocol Type B
Enter 6112 for both Private Port and

Public Port Click Always or set a
schedule.

Step 4 Click Apply and then Continue.

Note: If you want multiple computers from you LAN to play in the same game that
you are hosting, then repeat the steps above and enter the IP Addresses of the other
computers. You will need to change ports. Computer #2 can use port 6113, computer
#3 can use 6114, and so on.

You will need to change the port information within the Warcraft 3 software for
computers #2 and up.

Configure the Game Port information on each computer:
Start Warcraft 3 on each computer, click Options > Gameplay. Scroll down and you

should see Game Port. Enter the port number as you entered in the above steps.
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Frequently Asked Questions (continued)

How does NetMeeting work with my D-Link Router?

Unlike most TCP/IP applications, NetMeeting uses DYNAMIC PORTS instead of
STATIC PORTS. That means that each NetMeeting connection is somewhat different
than the last. For instance, the HTTP web site application uses port 80. NetMeeting
can use any of over 60,000 different ports.

All broadband routers using only standard NAT and all internet sharing programs like
Microsoft ICS that use only standard NAT will NOT work with NetMeeting or other
h.323 software packages.

In order to use NetMeeting with your D-LInk router, you need to put the router in DMZ.

Note: Afew hardware manufacturers have taken it on themselves to actually provide
H.323 compatibility. This is not an easy task since the router must search each
incoming packet for signs that it might be a netmeeting packet. This is a whole lot
more work than a router normally does and may actually be a weak point in the
firewall. D-Link is not one of the manufacturers.

To read more on this visit http://www.HomenetHelp.com

How do | set up my router to use iChat? -for Macintosh users-

You must open ports on your router to allow incoming traffic while using iChat.
iChat uses the following ports: 5060 (UDP) 5190 (TCP) File Sharing 16384-16403
(UDP) to video conference with other clients

Step 1 Log into the web based configuration by typing in the IP Address of the router
(default:192.168.0.1) in your web browser. The username is admin (all lowercase) and
the password is blank (empty).

Step 2 Click on Advanced and then click Firewall.
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Frequently Asked Questions (continued)

(continued)

How do | set up my router to use iChat? -for Macintosh users-

Step 3 Create a new firewall rule:

Click Enabled.
Enter a name (ichatl).

Click Allow.

Next to Source, select
WAN under interface.

In the first box, enter an *.
Leave the second box
empty.

Next to Destination, select
LAN under interface.

Enter the IP Address of the
computer you are running
iChat from.

S

nk

BUIKImg Nerworks for Peopie

—_—

Virtual Server

Application

Filter

Firewall

SNMP

DDNS

Routing

g

iR

LD

H
N

DI-704UP
Ethernet Broadband Router

Tools Status Help

BLIIT Advanced

Firewall Rules can be used to allow or deny traffic fom passing through the D-T04UP,

@Enahled ODisabled

Name lichat1 il
Action @ 4low © Deny
Interface 1P Start 1P End Protocol  Port Range
Source [wan > [ |
Destination [ 1an %] 1921680100 | | | [Usp*| [s060 |
athedule @ Aways
O From  Time 08 v[00 (vfro[00 v (00 v
day|sn ¥to[on V]
Apply Cancel Help
Astion Narme Source Destination  Protocal

2 Allow Allow 10 Ping WAN port iAN* LAN192.168.0.1 ICMP,* )]

P LAN - i
v Deny Default : o [E]il]
+ Allow Defautt LAN =-19216801 = (3]

Leave the second box empty. Under Protocol, select UDP. In the port range boxes,
enter 5060 in the first box and leave the second box empty.

Click Always or set a schedule.

Step 4 Click Apply and then
Continue.

Step 5
Repeat steps 3 and 4 enter
ichat2 and open ports 16384-

16403 (UDP).

¢

L9 E

Virtual Server

Application

Filter

Firewall

DDNS

il

N

k

DI-704UP
Ethernet Broadband Router

Tools Status

BLIIT Advanced

Firewall Rules can be used to allow or deny traffic from passing through the DIF704UF.

Help

@Enabled O Disabled

Narne [ichat2 i
Action @ nllow O Deny
Interface I Start P End Protocal  PortRange
suce  wawel [ ] [ ]
Destnation [LAN | (1921680100 | | | [upP~] 1638 1640 |
Schedule ® pways
O From  Time|00 ¥|[00 ¥ To[00 %[00 v
day[sun ] 1o[sn ¥
Apply Cancel Help
ActionName Source Destinaion  Protacel

¥ Allow Allowto Ping WAN port AN, LAN,192168.0.1 IWP,* £l ]

Len- o
v Deny Defaut e E{]
¥ Allow Dsfault LA 18218801 *F El]
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Frequently Asked Questions (continued)

How do | set up my router to use iChat? -for Macintosh users-
(continued)

For File Sharing: D-Link T
Step 1 Click on Advanced and E&herne’t!m—udbnnd Router
then Virtual Server. [ Home [.YVEYTTTE Tools Status Help
Step 2 Check Enabled to activate e @Eraties Osanies
Narne s ]
e ntl’y. Virtual Server Private IP Wi\
Protocol Type  [TcP |
. Private Port [6500 ]

Step 3 Enter a name for your virtual Pwicren  osoo |
server entry (ichat3). R Bty
Step 4 Next to Private IP, enter the 290
IP Address of the computer on your B
local network that you want to allow |zl VSRR RS IR HE an
the incoming service to. AT 0 BT N

Virtual Server DNS 0.0.0.0 UDP 53163  always [E}]

Virtual Server SMTP 0.0.00 TCP25/25  always )i ]
Step 5 Select TCP for Protocol Virtual Server POP3 0.0.0.0 TCP110/110 always gﬂ
Type_ IPset 0.000 TCP 5001500 always R

PRTP 0000 ToRATE amaye [E}])

. DCE1000 0.0.0.0 BothB0/B0  always [Ef]

Step 6 Enter 5190 next to Private oon BN g G
Port and Public Port. e B s e

DCS2000 0.0.0.0 5003 /5001 always [ M

Step 7 Click Always or configure a schedule.

Step 8 Click Apply and then Continue.

If using Mac OS X Firewall, you may need to temporarily turn off the firewall in
the Sharing preference pane on both computers.

To use the Mac OS X Firewall, you must open the same ports as in the router:

Step 1 Choose Apple menu > System Preferences.

Step 2 Choose View > Sharing.

Step 3 Click the Firewall tab.

Step 4 Click New.

Step 5 Choose Other from the Port Name pop-up menu.

Step 6 In the Port Number, Range or Series field, type in: 5060, 16384-16403.
Step 7 In the Description field type in: iChat AV

Step 8 Click OK.
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Frequently Asked Questions (continued)

How do | send or receive a file via iChat when the Mac OSX firewall
is active? -for Macintosh users- Mac OS X 10.2 and later

The following information is from the online Macintosh AppleCare knowledge base:

“iChat cannot send or receive a file when the Mac OS X firewall is active in its default
state. If you have opened the AIM port, you may be able to receive a file but not send
them.

In its default state, the Mac OS X firewall blocks file transfers using iChat or America
Online AIM software. If either the sender or receiver has turned on the Mac OS X firewall,
the transfer may be blocked.

The simplest workaround is to temporarily turn off the firewall in the Sharing preference
pane on both computers. This is required for the sender. However, the receiver may keep
the firewall on if the AIM port is open. To open the AIM port:

Step 1 Choose Apple menu > System Preferences.
Step 2 Choose View > Sharing.

Step 3 Click the Firewall tab.

Step 4 Click New.

Step 5 Choose AOL IM from the Port Name pop-up menu. The number 5190
should already be filled in for you.

Step 6 Click OK.

If you do not want to turn off the firewall at the sending computer, a different file sharing
service may be used instead of iChat. The types of file sharing available in Mac OS X are
outlined in technical document 106461, "Mac OS X: File Sharing" in the AppleCare Knowl-
edge base online.

Note: If you use a file sharing service when the firewall is turned on, be sure to click the

Firewall tab and select the service you have chosen in the "Allow" list. If you do not do
this, the firewall will also block the file sharing service. “
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Frequently Asked Questions (continued)

What is NAT?

NAT stands for Network Address Translator. Itis proposed and described in RFC-
1631 and is used for solving the IP Address depletion problem. Each NAT box has a
table consisting of pairs of local IP Addresses and globally unique addresses, by
which the box can “translate” the local IP Addresses to global address and vice versa.
Simply put, NAT is a method of connecting multiple computers to the Internet (or any
other IP network) using one IP Address.

D-Link’s broadband routers (ie: DI-704UP) support NAT. With proper configuration,
multiple users can access the Internet using a single account via the NAT device.

For more information on RFC-1631: The IP Network Address Translator (NAT), visit
http://www.fags.org/rfcs/rfc1631.html
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Technical Support

You can find software updates and user documentation on the D-Link website.

D-Link provides free technical support for customers within the United States and
within Canada for the duration of the warranty period on this product.

U.S. and Canadian customers can contact D-Link technical support through our
website, or by phone.

Tech Support for customers within the United States:
D-Link Technical Support over the Telephone:
(877) 453-5465
24 hours a day, seven days a week.

D-Link Technical Support over the Internet:
http://support.dlink.com
email:support@dlink.com

Tech Support for customers within Canada:
D-Link Technical Support over the Telephone:
(800) 361-5265
Monday to Friday 7:30am to 12:00am EST

D-Link Technical Support over the Internet:
http://support.dlink.ca
email:support@dlink.ca
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Warranty
(USA only)

Subject to the terms and conditions set forth herein, D-Link Systems, Inc. (“D-Link”) provides this Limited
warranty for its product only to the person or entity that originally purchased the product from:

. D-Link or its authorized reseller or distributor and
. Products purchased and delivered within the fifty states of the United States, the District of Columbia,
U.S. Possessions or Protectorates, U.S. Military Installations, addresses with an APO or FPO.

Limited Warranty: D-Link warrants that the hardware portion of the D-Link products described
below will be free from material defects in workmanship and materials from the date of original retail
purchase of the product, for the period set forth below applicable to the product type (“Warranty
Period”), except as otherwise stated herein.

1-Year Limited Warranty for the Product(s) is defined as follows:

. Hardware (excluding power supplies and fans) One (1) Year
. Power Supplies and Fans One (1) Year
. Spare parts and spare kits Ninety (90) days

D-Link’s sole obligation shall be to repair or replace the defective Hardware during the Warranty Period
at no charge to the original owner or to refund at D-Link’s sole discretion. Such repair or replacement will
be rendered by D-Link at an Authorized D-Link Service Office. The replacement Hardware need not be
new or have an identical make, model or part. D-Link may in its sole discretion replace the defective
Hardware (or any part thereof) with any reconditioned product that D-Link reasonably determines is
substantially equivalent (or superior) in all material respects to the defective Hardware. Repaired or
replacement Hardware will be warranted for the remainder of the original Warranty Period from the date
of original retail purchase. If a material defect is incapable of correction, or if D-Link determines in its sole
discretion that it is not practical to repair or replace the defective Hardware the price paid by the original
purchaser for the defective Hardware will be refunded by D-Link upon return to D-Link of the defective
Hardware. All Hardware (or part thereof) that is replaced by D-Link, or for which the purchase price is
refunded, shall become the property of D-Link upon replacement or refund.

Limited Software Warranty: D-Link warrants that the software portion of the product (“Software”)
will substantially conform to D-Link’s then current functional specifications for the Software, as set forth
in the applicable documentation, from the date of original retail purchase of the Software for a period of
ninety (90) days (“Warranty Period”), provided that the Software is properly installed on approved
hardware and operated as contemplated in its documentation. D-Link further warrants that, during the
Warranty Period, the magnetic media on which D-Link delivers the Software will be free of physical
defects. D-Link’s sole obligation shall be to replace the non-conforming Software (or defective media)
with software that substantially conforms to D-Link’s functional specifications for the Software or to
refund at D-Link’s sole discretion. Except as otherwise agreed by D-Link in writing, the replacement
Software is provided only to the original licensee, and is subject to the terms and conditions of the
license granted by D-Link for the Software. Software will be warranted for the remainder of the original
Warranty Period from the date or original retail purchase. If a material non-conformance is incapable of
correction, or if D-Link determines in its sole discretion that it is not practical to replace the non-
conforming Software, the price paid by the original licensee for the non-conforming Software will be
refunded by D-Link; provided that the non-conforming Software (and all copies thereof) is first returned
to D-Link. The license granted respecting any Software for which a refund is given automatically
terminates.

Non-Applicability of Warranty: The Limited Warranty provided hereunder for hardware and software
of D-Link’s products will not be applied to and does not cover any refurbished product and any product
purchased through the inventory clearance or liquidation sale or other sales in which D-Link, the sellers,
or the liquidators expressly disclaim their warranty obligation pertaining to the product and in that case,
the product is being sold “As-Is” without any warranty whatsoever including, without limitation, the
Limited Warranty as described herein, notwithstanding anything stated herein to the contrary.

Submitting A Claim: The customer shall return the product to the original purchase point based on its

return policy. In case the return policy period has expired and the product is within warranty, the
customer shall submit a claim to D-Link as outlined below:
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¢ The customer must submit with the product as part of the claim a written description of the Hardware
defect or Software nonconformance in sufficient detail to allow D-Link to confirm the same.

¢ The original product owner must obtain a Return Material Authorization (“‘RMA”) number from the
Authorized D-Link Service Office and, if requested, provide written proof of purchase of the
product (such as a copy of the dated purchase invoice for the product) before the warranty
service is provided.

«  After an RMA number is issued, the defective product must be packaged securely in the original or
other suitable shipping package to ensure that it will not be damaged in transit, and the RMA number
must be prominently marked on the outside of the package. Do not include any manuals or accessories
in the shipping package. D-Link will only replace the defective portion of the Product and will not
ship back any accessories.

¢« The customer is responsible for all in-bound shipping charges to D-Link. No Cash on Delivery
(“COD") is allowed. Products sent COD will either be rejected by D-Link or become the property of
D-Link. Products shall be fully insured by the customer. D-Link will not be held responsible for any
packages that are lost in transit to D-Link. The repaired or replaced packages will be shipped to the
customer via UPS Ground or any common carrier selected by D-Link, with shipping charges prepaid.
Expedited shipping is available if shipping charges are prepaid by the customer and upon request.

. Return Merchandise Ship-To Address
USA: 17595 Mt. Herrmann, Fountain Valley, CA 92708
Canada: 2180 Winston Park Drive, Oakville, ON, L6H 5W1 (Visit http://www.dlink.ca for detailed
warranty information within Canada)

D-Link may reject or return any product that is not packaged and shipped in strict compliance with the
foregoing requirements, or for which an RMA number is not visible from the outside of the package. The
product owner agrees to pay D-Link’s reasonable handling and return shipping charges for any product
that is not packaged and shipped in accordance with the foregoing requirements, or that is determined
by D-Link not to be defective or non-conforming.

What Is Not Covered: This limited warranty provided by D-Link does not cover: Products, if in D-Link’s
judgment, have been subjected to abuse, accident, alteration, modification, tampering, negligence, misuse,
faulty installation, lack of reasonable care, repair or service in any way that is not contemplated in the
documentation for the product, or if the model or serial number has been altered, tampered with, defaced
or removed; Initial installation, installation and removal of the product for repair, and shipping costs;
Operational adjustments covered in the operating manual for the product, and normal maintenance;
Damage that occurs in shipment, due to act of God, failures due to power surge, and cosmetic damage;
Any hardware, software, firmware or other products or services provided by anyone other than D-
Link; Products that have been purchased from inventory clearance or liquidation sales or other sales in
which D-Link, the sellers, or the liquidators expressly disclaim their warranty obligation pertaining to the
product. Repair by anyone other than D-Link or an Authorized D-Link Service Office will void this
Warranty.

Disclaimer of Other Warranties: EXCEPT FOR THE LIMITED WARRANTY SPECIFIED HEREIN, THE
PRODUCT IS PROVIDED “AS-IS” WITHOUT ANY WARRANTY OF ANY KIND WHATSOEVER INCLUDING,
WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY, FITNESS FOR APARTICULAR PURPOSE
AND NON-INFRINGEMENT. IFANY IMPLIED WARRANTY CANNOT BE DISCLAIMED INANY TERRITORY
WHERE APRODUCT IS SOLD, THE DURATION OF SUCH IMPLIED WARRANTY SHALL BE LIMITED TO
NINETY (90) DAYS. EXCEPTAS EXPRESSLY COVERED UNDER THE LIMITED WARRANTY PROVIDED
HEREIN, THE ENTIRE RISKAS TO THE QUALITY, SELECTION AND PERFORMANCE OF THE PRODUCT IS
WITH THE PURCHASER OF THE PRODUCT.
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Limitation of Liability: TO THE MAXIMUM EXTENT PERMITTED BY LAW, D-LINK IS NOT LIABLE
UNDER ANY CONTRACT, NEGLIGENCE, STRICT LIABILITY OR OTHER LEGAL OR EQUITABLE THEORY
FORANY LOSS OF USE OF THE PRODUCT, INCONVENIENCE OR DAMAGES OF ANY CHARACTER,
WHETHER DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL (INCLUDING, BUT NOT LIMITED TO,
DAMAGES FOR LOSS OF GOODWILL, LOSS OF REVENUE OR PROFIT, WORK STOPPAGE, COMPUTER
FAILURE OR MALFUNCTION, FAILURE OF OTHER EQUIPMENT OR COMPUTER PROGRAMS TO WHICH D-
LINK'S PRODUCT IS CONNECTED WITH, LOSS OF INFORMATION OR DATACONTAINED IN, STORED ON,
OR INTEGRATED WITHANY PRODUCT RETURNED TO D-LINK FOR WARRANTY SERVICE) RESULTING
FROM THE USE OF THE PRODUCT, RELATING TO WARRANTY SERVICE, OR ARISING OUT OF ANY
BREACH OF THIS LIMITED WARRANTY, EVEN IF D-LINK HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. THE SOLE REMEDY FORABREACH OF THE FOREGOING LIMITED WARRANTY IS
REPAIR, REPLACEMENT OR REFUND OF THE DEFECTIVE OR NON-CONFORMING PRODUCT. THE MAXIMUM
LIABILITY OF D-LINK UNDER THIS WARRANTY IS LIMITED TO THE PURCHASE PRICE OF THE PRODUCT
COVERED BY THE WARRANTY. THE FOREGOING EXPRESS WRITTEN WARRANTIES AND REMEDIES
ARE EXCLUSIVEANDARE IN LIEU OF ANY OTHER WARRANTIES OR REMEDIES, EXPRESS, IMPLIED OR
STATUTORY

Governing Law: This Limited Warranty shall be governed by the laws of the State of California. Some
states do not allow exclusion or limitation of incidental or consequential damages, or limitations on how
long an implied warranty lasts, so the foregoing limitations and exclusions may not apply. This limited
warranty provides specific legal rights and the product owner may also have other rights which vary
from state to state.

Trademarks: D-Link is a registered trademark of D-Link Systems, Inc. Other trademarks or registered
trademarks are the property of their respective manufacturers or owners.

Copyright Statement: No part of this publication or documentation accompanying this Product may
be reproduced in any form or by any means or used to make any derivative such as translation,
transformation, or adaptation without permission from D-Link Corporation/D-Link Systems, Inc., as
stipulated by the United States Copyright Act of 1976. Contents are subject to change without prior

notice. Copyright® 2002 by D-Link Corporation/D-Link Systems, Inc. All rights reserved.

CE Mark Warning: This is a Class B product. In a domestic environment, this product may cause radio
interference, in which case the user may be required to take adequate measures.

FCC Statement: This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This equipment generates, uses, and
can radiate radio frequency energy and, if not installed and used in accordance with the instructions,
may cause harmful interference to radio communication. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user is encouraged
to try to correct the interference by one or more of the following measures:

. Reorient or relocate the receiving antenna.

. Increase the separation between the equipment and receiver.

. Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

. Consult the dealer or an experienced radio/TV technician for help.

For detailed warranty outside the United States, please contact corresponding local
D-Link office.
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